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ABSTRACT 
 
 

A delay line phase shifter for the 30-70 GHz range is presented that uses an 

aluminum micro-ribbon array fabricated in the ground plane of a microstrip transmission 

line.  Phase shift is achieved by changing the propagation velocity of an RF signal in 

the transmission line by controlling the effective permittivity of the substrate.  This is 

done by actuating the micro-ribbons away from the substrate.  This phase shifter has the 

benefits of analog phase shifts and high Figure of Merit.  Simulations were done to model 

the micro-ribbon deflections, transmission line performance and phase shift.  Arrays of 5, 

10, and 20 μm wide micro-ribbons were fabricated and tested.  At 40.80 GHz, the 20 μm 

wide micro-ribbons had a measured phase shift of 33º with an actuation voltage of 120 V.  

The corresponding Figure of Merit was a negative value indicating that there was no line 

loss due to ribbon deflection.  
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CHAPTER 1 
 
 
INTRODUCTION 
 
 
 
 
 
 
 
 
 
 
1.1  Motivation 
 

 Phase shifters are important components in large-phased array antenna systems 

used for beam steering applications [1].  Modern phase shifters are mainly based on p-i-n 

diodes, field emitting transistors (FET) and ferromagnetic materials.  However, as the 

applications move up in frequency (GHz), the insertion loss in the current systems 

becomes more significant [2].  In recent years, microelectromechanical-based (MEMS) 

solutions have been developed and presented [3].  These phase shifters are usually based 

on FET designs.  However, instead of utilizing FETs for the switches, researchers have 

used MEMS switches.  Some of these devices are discussed in Chapter 3. 
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 A phase shifter is a component that can be inserted in series with a transmission 

line in order to obtain a phase shift in the signal as can be see in Figure 1.1. 

 

 

 
Fig. 1.1:   Diagram of a transmission line and a transmission line with a phase 

shifter.  The phase shifter delays the signal by θ degrees. 
 

 As shown in Figure 1.1, with the addition of a phase shifter in the transmission 

line, the output signal of the system at the reference plane is the original signal with a 

phase shift.   

 The ability to obtain a phase shift is important in large-phased array antenna 

systems.  Figure 1.2 shows a simple 2x1 array antenna system.  By controlling the phase 

of the signal on one of the antennas, it is possible to use constructive and destructive 

interference to create a focused beam.  The amount of phase shift required for a phase 

shifter in a beam steering application depends on the application in question [1].  For 

instance, a satellite system would only need to be able to adjust the direction of the beam 

by a few degrees to maintain its directionality.  However, a missile tracking system on a 

naval ship would need to be able to track the whole sky so a phase shifter that allows for 

360º of phase shift would be required [2]. 
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Fig. 1.2:  A 2x1 phased array antenna illustrating how the addition of a phase 
shifter on one of the lines can be used to cause constructive and 
destructive interference that allows for beam steering. 

 

1.2  Concept 
 

 In this thesis, a microstrip delay line phase shifter is described, which uses 

conducting flexible aluminum micro-ribbons as a means of bridging a ground plane slot.   

 

 

 
Fig. 1.3:  Illustration of the micro-ribbon array concept. 
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Figure 1.3 illustrates the concept with the transmission line fabricated running 

parallel to the ribbon-shorted ground plane slot.  A pull-down electrode placed below the 

ribbons is used to deflect the micro-ribbons away from the radio frequency (RF) 

substrate, introducing a controllable air gap between the ribbons and the RF substrate.  

This in turn controls the effective dielectric constant of the substrate in the micro-ribbon 

region, and so introduces a phase shift between the input and output signals.  Figure 1.4 

illustrates the orientation of the transmission line and the micro-ribbon array.  Figure 1.5 

is a photograph of a micro-ribbon array. 

 

 

Fig. 1.4:  Top view of the phase shifter showing the orientation of the 
transmission line over micro-ribbons. 

 
 
 

 
 
Fig. 1.5:  Photograph of a micro-ribbon array that spans a length of 3 mm. 
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The phase velocity of an electromagnetic wave in a microstrip line is given by: 

00

1
μμεε rr

velocity =             (1.1) 

where μr is the permeability of the substrate (μr =1 for non-magnetic materials), and εr = 

εeff is the effective permittivity of the dielectrics [4].  In this case, the effective 

permittivity is a function of the thickness of the stacked air gap (d2) and silicon (d1) as is 

seen in Figure 1.6. 

 

 

Fig. 1.6:  Schematic showing the thickness of the stacked dielectrics in the phase 
shifter setup. 

 

The phase shift occurs because the permittivity of the region between the 

transmission line and ground plane is being changed as the air gap is introduced.  The 

effective permittivity εeff can be derived approximately from adding the dielectric 

capacitances in series: 

 

102

210 )(
dd
dd

r

r
eff εε

εε
ε

+
+

=                          (1.2) 

 

where εr and d1 are the permittivity and the thickness of the silicon, and ε0 and d2 are the 

permittivity and the thickness of the air gap, respectively.  Figure 1.7 shows the effective 

permittivity for a stacked dielectric of silicon and air as a function of the fraction of air in 
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the total thickness of the stacked dielectric.  It should be noted that the initial introduction 

of air into the stacked dielectrics is significant because it introduces the largest gradient 

change in the effective permittivity and thus it is where the largest gradient change in 

phase shift occurs. 
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Fig. 1.7:  Plot of the effective permittivity of stacked dielectrics (silicon and air) 
ranging from 0% - 100% air to silicon ratio. 

 
 
 
1.3  Thesis Objectives 
 
 

The first goal of this phase shifter project was to have a simple fabrication 

process.  This means limiting the number of masks required to create the device.  The 

second goal of the phase shifter design was to reduce the pull-down voltage required in 

the electrostatic actuation in comparison to a previous design by Shafai [5] discussed in 

section 3.3.3.  Lastly, the phase shifter should be capable of analog phase shifts.  

The fabrication of this phase shifter was done entirely in the Nanosystems 

Fabrication Laboratory (NSFL) located at the University of Manitoba.  Through this 
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process, my goal was to gain experience in a nanosystems fabrication laboratory as well 

as learn to use simulation tools in order to design and characterize the phase shifter. 

 
 
1.4  Organization of the Thesis 
 

 Chapter 2 is a brief overview of MEMS and micromachining techniques.  

Applicable material deposition and etching techniques are also discussed.  In Chapter 3, 

the theory for electrostatic actuators and MEMS-based phase shifters are presented.  

Examples of delay line and distributed line phase shifters are also presented.   

Chapter 4 is where the design and modeling of the micro-ribbons is presented.  

This chapter focuses on the simulations done in a program called COMSOLTM [6] in 

order to finalize the micro-ribbon geometry.  In Chapter 5, the fabrication of the micro-

ribbons is discussed.  This includes the general fabrication of the overall system as well 

as a more focused discussion of the fine-tuning of the dry release process which involved 

different plasma etch recipes.  In Chapter 6, the deflection testing of the micro-ribbon is 

discussed, and the results are compared to the results obtained through the simulations.  

Chapter 7 contains the phase shift simulations done in HFSSTM [7] and the actual phase 

shift measurements.  Finally, in Chapter 8, the conclusions of this work are discussed and 

future work and recommendations are also presented. 
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CHAPTER 2 
 
 
MEMS AND MICROMACHINING 
 
 
 
 
 
 
 
 
 
 
2.1  MEMS 
 
 
 Micro-electro-mechanical systems (MEMS) is a field in which micro-mechanical 

structures are fabricated typically using integrated circuit (IC) fabrication processes.  By 

using IC fabrication techniques, researchers have been able to build small, accurate 

mechanical structures that can be built on the same chip as their electrical control/sensing 

components.  Specific MEMS devices will be presented in Chapter 3. 
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2.2  Micromachining Techniques 
 

Some micromachining techniques will be explained briefly here because they are 

relevant to the fabrication process used in this thesis.  Readers unfamiliar with 

micromachining techniques are directed to [8] for a broad background of MEMS 

techniques and devices. 

 
2.2.1  Method of Material Deposition: Sputtering 
 

 Sputtering was the only deposition technique used in this work, although there are 

many different techniques to deposit materials in the field of MEMS, such as chemical 

vapour deposition (CVD), thermal evaporation, and electroplating. 

 Sputtering is a method of depositing material onto a wafer where a target, usually 

a round disc of the desired material to be deposited, is located in proximity to the 

substrate inside a parallel-plate plasma reactor chamber [9] (Fig. 2.1).  The chamber is 

then evacuated of the ambient air and a small quantity of argon gas is flowed into the 

chamber typically at pressures on the order of 50 mTorr.  The argon gas is ionized and 

the high energy ions bombard the target and knock off material, which is then deposited 

onto the wafer.   
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Fig. 2.1:  Schematic of a sputter system showing the parallel-plate reaction 
chamber, and the target and wafer positions. 

 

Two of the parameters that affect sputter deposition film quality are chamber 

pressure and ion energy.  By controlling the chamber pressure, the mean free path of 

sputtered target atoms is controlled.  The ion energy on the other hand, is controlled by 

the voltage applied to the target.  The higher the voltage, the more energy the ions will 

have.  By adjusting these two parameters, both the deposition rate and the characteristics 

of the deposited layer can be controlled.   

 
2.2.2  Lithography 
 

 Lithography is the process used to transfer a mask image to a photoresist coated 

wafer.  The patterned photoresist is then used to mask specific areas on the wafer for 

subsequent etching procedures.  Photoresist is a special polymer that is sensitive to UV 

light.  When the photoresist is exposed to UV light, the exposed area chemically changes 
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and, in the case of positive photoresist, can be easily washed away in a developer 

solution.  Subsequent to developing, the photoresist is baked in an oven (hard bake), 

making it more durable for subsequent etch processes.  Figure 2.2 is a flow chart of the 

typical lithography process. 

 

 

Fig. 2.2:  Flow chart of a typical lithography process. 
 
 

 There are several parameters that need to be considered when doing lithography.  

One parameter is the thickness of the photoresist, which is controlled by choosing the 

appropriate spin rate for the wafer when the photoresist is applied.  Specific thicknesses 

of photoresist correspond to different rotation rates of the photoresist spinner.  The 

thickness of the photoresist layer determines how long the photoresist needs to be 

exposed to the UV light.  The length of exposure is the second parameter that needs to be 

considered.  If the photoresist is thicker, it will require a longer exposure time.   
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2.2.3  Etching Methods 
 

Etch methods can be broken up into two basic groups:  wet etching and dry 

etching.  The type of etch method chosen depends on what material is to be removed and 

also what etch profile is desired. 

 

 

Fig. 2.3:  Etch profiles for different types of etches.  (a) Isotropic etch typical of 
wet etch processes, (b) anisotropic KOH etch profile due to etching of 
a <100> silicon wafer, (c) vertical anisotropic etch possible in RIE 
etch systems. 

 

In a wet etch process, the wafer is immersed usually in an acid/base which 

chemically attacks the material to be removed.  Most wet etch processes typically result 

in an isotropic etch (etches laterally as it etches vertically) (Fig. 2.3(a)).  Some etchants, 

however, can anisotropically etch materials.  In an anisotropic etch, the etch rate is not 

the same in all directions.  For example, potassium hydroxide (KOH), etches the silicon 

<111> crystal plane much slower than the <100> plane.  Therefore, when etching a 

<100> silicon wafer, sloped sides at the etch boundary occur, resulting in a side wall 

slope of 54.74º relative to the surface (Fig. 2.3(b)). 
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There are several dry etch methods.  One example is XeF2 gas etch which is an 

isotropic silicon etch which etches according to the following chemical reaction.    

42 22 SiFXeSiXeF +→+  

Another dry etch method involves bombarding the surface with high energy ions, 

where the material to be removed is eroded.  Ion bombardment-based etches can result in 

uniform vertical etch profiles (Fig. 2.3(c)).  By selecting the appropriate gases and power 

levels, Reactive Ion Etching (RIE) can result in etches that are mainly chemical or in 

etches that are mainly due to physical bombardment.  Further discussion on dry etching 

can be found in Chapter 5 in the fabrication process. 
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CHAPTER 3 
 
 
BACKGROUND 
 
 
 
 
 
 
 
 
 
 
 
3.1  Overview 
 

In this chapter, the theory behind electrostatic actuators is discussed.  Several 

types of phase shifters such as delay line, distributed line, and defected ground plane 

based phase shifters will be presented, and the phase shifting mechanisms will be 

explained.  
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3.2  Electrostatic Actuators 
 

Electrostatic actuation has been used for cantilevers [10], electrostatic comb 

drives [11], and rotary micromotors [12].  Electrostatic actuators act on the basic 

principle that opposite charges are attracted to each other.  These actuators are simple to 

fabricate because they are essentially made of two conducting plates with a small gap in 

between them.  Electrostatic actuation has the benefit of requiring no holding power.  

However, the force to voltage relationship is nonlinear. 

 To estimate the electrostatic force in these actuators, Coulomb’s Law can be used 

to determine the force between two charges, 

 2
21

4
1

x
qqF

or
elec επε

=   (3.1) 

where q1 and q2 are the two charges in coulombs and x is the distance separating them.  

With more than two charges, it becomes necessary to determine the force between each 

pair of charges and use the principle of superposition to find the total resultant force.  

Finite element methods are one way to do these more complex calculations. 

 A first order approximation of the force can be found by assuming a parallel plate 

capacitor with no fringing fields [8].  These approximations are only good for small 

deflections where the two surfaces are still parallel.  For a parallel plate capacitor, the 

energy stored at a given voltage, V, is given by, 

x
AV

CVW or
2
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1

2
1 εε

==                   (3.2) 

where A is the plate area of the capacitor and x is the distance between the two plates.  

The attractive force between the plates is then, 
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From equation 3.3, it is clear that the relationship between the applied voltage and the 

force exerted is non-linear.  

 
 
3.3  MEMS Phase Shifters 
  

Recently, many different MEMS-based phase shifters have been demonstrated 

[13-20].  These phase shifters can be classified into 3 main groups: delay/switch line, 

load line/distributed line and phase shifters based on a defected ground plane.  In 

reference [13], Rebeiz discussed many different MEMS-based phase shifter designs and 

their corresponding advantages and disadvantages. 

 There are a number of different metrics that can be used to compare different 

MEMS phase shifter designs.  One metric would be the footprint of the MEMS phase 

shifter on a chip.  Secondly, the actuation voltages required can be discussed.  Lastly, the 

Figure of Merit (FOM) of the phase shifters can be compared.  The FOM is defined as the 

ratio between the phase shift and the loss in dB’s.  These losses include the insertion 

losses of any micro-switches being employed and line losses.  The FOM of a good phase 

shifter should be greater than 100º/dB.  This indicates that for a full 360º phase shift, the 

signal is still better than 3 dB. 

 
3.3.1  Delay/switch Line Phase Shifters 
 

In delay line or switch line phase shifters, MEMS micro-switches are used to 

route the RF signal along transmission lines of different lengths.  By selecting the desired 



Chapter 3: Background 
 
     

17 

path of the RF signal, the total length of the transmission line is changed and large, 

discrete phase shifts can be achieved [14].  The different transmission line lengths are 

chosen by selecting certain “bits” which corresponding to switches that route the RF 

signal. 

 

Pillans, B. et al., “Ka-band RF MEMS phase shifters”  
Microwave and Guided Wave Letters, IEEE   

© (1999) IEEE.  All rights reserved.  Used with permission. 
 
Fig. 3.1:  Delay line phase shifter that uses micro-switches to re-route the RF 

signal to different transmission line segments [14]. 
 

Figure 3.1 shows a 4-bit phase shifter designed for the Ka band (40 GHz).  For 

switch-line phase shifters, the phase shift is linear with frequency.  The key component to 

the delay line phase shifter is the design of the RF MEMS switches.  These switches need 

to be low-loss.  They need to be designed so that they have low insertion loss when “on” 

and high isolation when “off”.  The micro-switches in this design had an average loss of 

0.25 dB/switch over the different line configurations.  At 34 GHz, to achieve a 315º 

phase shift, the insertion loss was 2.2 dB which translates to a Figure of Merit of 143º/dB 

of insertion loss.  The actuation voltage for the individual switches was 45 V, and the 

switch times were 3-6 μs.  As can be seen in the figure, the 4-bit phase shifter’s area is 5 

mm x 10 mm.  
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 Current work in the switch-line phase shifter area involves improving the MEMS 

micro-switches to decrease signal loss [15, 16].  The 3-port MEMS switch discussed in 

[16], is used in a 5-bit switched-line phase shifter [17] shown in Figure 3.2.  The footprint 

of the phase shifter is 7 mm x 4 mm.  The actuation voltage for the micro-switch is 25 V.  

The 3-port MEMS switch has an insertion loss of 0.66 dB at 10 GHz.  With an average of 

3.6 dB insertion loss for the entire system, assuming a phase shift of 300º, the Figure of 

Merit would be 83º/dB of insertion loss.   Note how the geometry of the delay lines is 

designed in order to minimize the area required for the phase shifter. 

 

 

Jian, Z., et al., “A Compact 5-bit Switched-line Digital MEMS Phase Shifter” 
Proceedings of 1st IEEE International Conference on Nano/Micro Engineered and Molecular Systems 

© (2006) IEEE.  All rights reserved.  Used with permission. 
 

Fig. 3.2:  Photograph of a 5-bit phase shifter with a die size of 7 mm x 4 mm [17].  
 

 A disadvantage of switched, delay-line phase shifters is that if one of the micro-

switches fails, the whole phase shifter fails.  These phase shifters are also limited to 

discrete phase shifts due to the limited possible signal paths.  Also, since the RF signal is 

routed through the MEMS micro-switches, there are necessary device power limitations 

RF input RF output
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to prevent micro-switch failures.  Power levels over a few milliwatts typically are enough 

to damage the switches. 

 
3.3.2  Load line/distributed Line Phase Shifters 
 

 Barker and Rebeiz were among the first to do extensive work on distributed 

MEMS transmission lines (DMTL) [18].  The DMTL is made of a high impedance line 

(>50 Ω) that is periodically loaded by MEMS bridges that act as capacitors.  By 

controlling the load impedance of the transmission line, a phase shift can be achieved.  

The FOM of DMTL phase shifters is slightly worse in terms of line loss compared to 

those of switch-line phase shifters for frequencies up to 30 GHz, but DMTL phase 

shifters become competitive and even surpass switch-line phase shifters at frequencies of 

40 GHz and above [19]. 

 In reference [20], Hung et al. demonstrated a Ka-band DMTL phase shifter on a 

silicon substrate using AlSi bridges.  The phase shifter used 13 MEMS bridges at a 

spaced 540 μm apart (Fig. 3.3).  The bridges were fabricated out of an AlSi alloy in order 

to increase flexibility.  The actuation voltage of the MEMS bridges was 27 V. 
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Qing, J., et al., “Ka-band Distributed MEMS Phase Shifters on Silicon Using AlSi Suspended Membrane” 

Journal of Microelectromechanical Systems 
© (2004) IEEE.  All rights reserved.  Used with permission. 

 
Fig. 3.3:  SEM photograph of a MEMS bridge in a DMTL [20]. 

 

As can be inferred from the figure, the DMTL fabrication process requires 

multiple metal layers.  Also, the transmission line length needs to be long in order to 

accommodate all the MEMS bridges, 7.56 mm in this example.  However, DMTL phase 

shifters are capable of operating over larger bandwidths than the switch-line phase 

shifters.  At 36 GHz, a phase shift of 286º was achieved with an insertion loss of 1.75 dB.  

This translates to a Figure of Merit of 163º/dB of insertion loss. 

 In reference [19], a 2- and 3-bit W-Band DMTL phase shifter on a glass 

substrate was demonstrated.  The 3-bit version used a total of 32 bridges.  The 45º-bit 

used 4 bridges, the 90º-bit was made up of 8 bridges, and the 180º-bit was made up of 16 

bridges (Fig. 3.4).  More bridges are required to achieve larger phase shifts.  This phase 

shifter had an area of 1.92 mm x 5.04 mm and the measured pull-down voltage was 30 V.  

540 μm 
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The phase shifter performed well for a wide frequency range.  Reported FOM were 

93º/dB – 100º/dB of insertion loss at 75-110 GHz. 

 

 
 

Hung, J.-J., et al., “Distributed 2- and 3-bit W-band MEMS Phase Shifters on Glass Substrates” 
IEEE Transactions on Microwave Theory and Techniques 

© (2004) IEEE.  All rights reserved.  Used with permission. 
 

Fig. 3.4:  Photograph of a 3-bit W-band DMTL [19]. 
 

  
3.3.3 Defected Ground Plane Phase Shifters 
 

 A reconfigurable ground plane based phase shifter was demonstrated in reference 

[5].  The use of corrugated membranes in the ground plane allows for a phase shift to 

occur when the membrane is electrostatically deflected away from the RF substrate (Fig. 

3.5).  An example of a corrugated membrane can be seen in Figure 3.6. 
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Shafai, C., et al., “Microstrip Phase Shifter Using Ground-Plane Reconfiguration” 

IEEE Transactions on Microwave Theory and Techniques 
© (2004) IEEE.  All rights reserved.  Used with permission. 

 
Fig. 3.5:  Schematic of the corrugated membrane based phase shifter of [5]. 

 
 
 

 

Shafai, C., et al., “Microstrip Phase Shifter Using Ground-Plane Reconfiguration” 
IEEE Transactions on Microwave Theory and Techniques 

© (2004) IEEE.  All rights reserved.  Used with permission. 
 
Fig. 3.6:  Photograph of corrugated membrane used in the reconfigurable ground 

plane of [5]. 
 
 

A series of five 4.3 mm diameter circular membranes was used to achieve a phase 

shift of 30º at 12.08 GHz and 32º at 15.00 GHz.  A 10.4 mm diameter membrane showed 

a phase shift of 56º at 14.25 GHz.  Even though the membranes were corrugated to 

improve flexibility, the actuation voltage, 405 V, was still quite large due to the 0.45 mm 

separation distance between the corrugated membranes and the pull-down electrode.  In 

these phase shifters, the insertion loss is not dependent on the membrane deflection, so 
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high Figures of Merit can be achieved.  With a single membrane 10.4 mm in diameter, 

the Figure of Merit at 11 GHz was 708º/dB of line loss for a 37º phase shift, and at 14.25 

GHz, the Figure of Merit was 612º/dB of line loss for a 55º phase shift.  Also, the RF 

power limitations that occur in switch-line phase shifters do not apply to this device. 

 The micro-ribbon arrays presented in this thesis operate under the same principles 

as the corrugated membrane phase shifter just described.  The required actuation voltage 

could be reduced since the micro-ribbon array was more flexible than the corrugated 

membranes.  The actuation voltage was also reduced because the micro-ribbon arrays 

could be fabricated in such a way that reduced the separation distance between the 

ground and the pull-down electrode.   
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CHAPTER 4 
 
 
DESIGN AND MODELING OF MICRO-RIBBONS 
 
 
 
 
 
 
 
 
 
 
4.1  Overview 
 

This chapter of the thesis describes the finite-element modeling (FEM) of the 

micro-ribbons using the software tool, COMSOLTM[6].  There simulations were carried 

out in order to investigate the mechanical properties of the micro-ribbons.  The evolution 

of the simulation setup is explained and discussed.  This includes the explanation of the 

adjacent ground planes in the simulations that were introduced to decrease computation 

time and yet model the environment accurately.  Different micro-ribbon geometries are 

presented and compared with each other.   
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4.2  Simulation Setup 
 

The simulator COMSOL MultiphysicsTM [6] is a finite-element modeling (FEM) 

program that allows for a variety of multiphysics simulations.  It is an appropriate 

software tool to model the electrostatic actuation of the micro-ribbon array because it 

allows for mechanical and electrostatic modeling in the same simulation.  COMSOL was 

used to simulate the electrostatic fields that exist between the grounded micro-ribbons 

and the pull-down electrode.  It then applied the calculated electrostatic forces to the 

structure in order to simulate the corresponding micro-ribbon deflection. 

The MEMS module of COMSOL was used with the “Electrostatics” and 

“Structural Mechanical – solid, stress-strain” sub-modules.  The multiphysics simulations 

were done in 3D.  For the electrostatic part of the simulation, the micro-ribbon was 

grounded while an “electric potential” boundary condition was applied to the pull-down 

electrode.  Next, a problem space was defined around the model, and the boundary 

condition on this space was “zero symmetry”.  For the mechanical section of the 

multiphysics simulation, only the micro-ribbon being simulated was active in that 

domain.  The ends of the micro-ribbons were constrained, and the corresponding 

electrostatic force was applied to the other edges of the micro-ribbons (Table 4-1 and 

Table 4-2).  Appendix A presents a step by step procedure for the COMSOL simulation 

set up. 
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Table 4-1:  Boundary conditions for the electrostatic sub-module. 
 

Simulation Component Boundary Condition 
bounding box Zero charge/symmetry 

  
micro-ribbon ground 

  
pull-down electrode electric potential 

 
 

              Table 4-2:  Boundary conditions for the mechanical-plane stress sub-module. 
  

Simulation Component Boundary Condition 
Micro-ribbon ends Constrained in x, y, and z 

  

 
Remaining micro-ribbon 

surfaces 
 
 
 
 
 

 

Fx = -0.5Vx * nD_es * 
Fy = -0.5Vy * nD_es * 
Fz = -0.5Vz * nD_es  

(where Vx, Vy, Vz, and nD_es 
(charge density) are values 

calculated by the electrostatics 
module) 

 
*Fx and Fy are 12 or 13 orders of 
magnitude smaller than Fz in the 
simulations presented. 

  
 
 

During the initial simulations, it was noted that the width of the bounding box 

(Fig. 4.1) affected the force on the micro-ribbon being simulated.  In these simulations, a 

single micro-ribbon was simulated rather than simulating an entire array of micro-ribbons 

in order to reduce computation time.  A problem with this technique was that for 

simulations that required a larger bounding box, a larger electrostatic force was observed 

on the micro-ribbon.  The large force resulted in different deflections for a constant 

applied voltage that was dependent on the bounding box dimensions.    
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Fig. 4.1:  Illustration of the COMSOL simulation bounding box. 
 

One solution to this problem would be to choose a width large enough to include 

most of the fringing capacitance due to the fringing fields (Fig. 4.2).   However, this 

would not be an accurate simulation with regard to the actual final experimental setup.  A 

typical micro-ribbon in the array would have adjacent ribbons that would reduce the 

actual electrostatic force that was applied to the micro-ribbon.   

 

 

Fig. 4.2:  Illustration of the fringing fields on a micro-ribbon, showing the field 
extension beyond the ribbon width. 

 

In order to solve the problem mentioned above, adjacent rigid ground strips were 

introduced in the simulation.  In this simulation setup, one micro-ribbon was simulated 

with air gaps to represent the separation distance between ribbons in the array and rigid 

grounds adjacent to the micro-ribbon (Fig. 4.3).   
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Fig. 4.3:  Illustration of the simulation setup with adjacent rigid grounds. 
 
 
This setup was the solution to a few problems.  Firstly, with the rigid grounds in 

place, the electrostatic force was no longer dependent on the width of the ground plane 

being simulated.  Secondly, the addition of the rigid ground planes helped to reduce 

computation times.  Since the majority of the computation time was used to determine the 

mechanical deflection of the micro-ribbon, having the adjacent grounds being rigid it did 

not increase the computation time.  Also, the rigid ground sections allowed for an 

accurate simulation of a single micro-ribbon with the correct fringing capacitance without 

having to simulate the entire micro-ribbon array for small deflections.  

For most of the simulations, the problem box was defined to be 3.5 mm x 1 mm x 

120 μm (Table 4-3).  These dimensions were chosen after several simulations were done 

with smaller and larger bounding boxes.  Typical simulations had ~60000 mesh elements 

with 130000+ degrees of freedom. 

Pull Down Electrode 

Micro-Ribbon 

Adjacent Rigid Grounds 

Separation between 
ribbons 
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     Table 4-3:  Bounding box dimensions in a typical simulation. 
 

Bounding box Dimension 
length 3.5 mm 
width 1 mm 
height 120 μm 

 

The majority of the simulations discussed in this chapter and thesis were done as 

described above.  These simulations were useful for relating specific electrostatic forces 

with their corresponding micro-ribbon deflection.  However, it should be noted that even 

though the voltage was set for the simulations, the corresponding micro-ribbon deflection 

would be underestimated, because the meshing was not dynamic. i.e., the electrostatic 

force that produced the deflection was only calculated for the initial zero-deflection.  In 

practice, as the micro-ribbon gets closer to the pull-down electrode, the electrostatic force 

would increase because the separation distance between the micro-ribbon and pull-down 

electrode had decreased.  Simulations of this type will always be denoted as simulations 

with adjacent rigid grounds. 

A second type of simulation was also done on a few occasions.  These simulations 

were not multiphysics simulations.  They only used the structural mechanics – solid, 

stress-strain module.  In these simulations, only the micro-ribbon was represented, and a 

uniform pressure was applied to the micro-ribbon.  These simulations were useful to 

enable quick comparisons of different micro-ribbon geometries to determine differences 

in spring constant and resonant frequencies. 
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4.3   Straight Micro-Ribbons 
 

It would be beneficial to study the behaviour of a simple straight beam before 

simulations of more complex micro-ribbon designs are discussed.  A few simulations 

were therefore carried out using the dimensions for the straight beams found in Table 4-4. 

    
     Table 4-4:  Dimensions of the straight beams simulated. 
 

Beam Length (μm) Width (μm) Thickness 
(μm) 

Separation from 
adjacent ribbons (μm) 

1 3000 20 1 50 
2 3000 50 1 50 

 

Two simulations were done using Beam 1 with the adjacent rigid grounds.  The 

first simulation was for voltages ranging from 1-6 V.  The second simulation was for 

voltages ranging from 5-30 V.  The results can be seen in Table 4-5 and Table 4-6.  A 

similar simulation was done for Beam 2 (a beam that is 2.5 times wider than Beam 1) for 

voltages ranging from 5-30 V with adjacent rigid grounds (Table 4-7).   These tables 

show the voltages, maximum deflection, electrostatic force (in the z-direction), and 

spring constant, where, 

 

Spring Constant, k 
CentreRibbonAtDeflectionMaximum

ForceticElectrostaTotal
    

  
=      (4.1) 

 

The total electrostatic force was determined by doing a boundary integration across the 

entire micro-ribbon in order to find the total Fz. 
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Table 4-5:  Deflection and force on Beam 1 with voltages ranging from 1-6 V. 
 

Voltage 
(V) 

Maximum 
Deflection (m) 

Electrostatic Force
(N) 

Spring Constant 
(N/m) 

1 3.2 x 10-8 5.5 x 10-11 1.7 x 10-3 
2 1.3 x 10-7 2.2 x 10-10 1.7 x 10-3 
3 2.9 x 10-7 4.9 x 10-10 1.7 x 10-3 
4 5.2 x 10-7 8.7 x 10-10 1.7 x 10-3 
5 8.1 x 10-7 1.4 x 10-9 1.7 x 10-3 
6 1.2 x 10-6 2.0 x 10-9 1.7 x 10-3 

  

Table 4-6:  Deflection and force on Beam 1 with voltages ranging from 5-30 V. 
 

Voltage 
(V) 

Maximum 
Deflection (m) 

Electrostatic Force
(N) 

Spring Constant 
(N/m) 

5 8.1 x 10-7 1.4 x 10-9 1.7 x 10-3 
10 3.2 x 10-6 5.5 x 10-9 1.7 x 10-3 
15 7.3 x 10-6 1.2 x 10-8 1.7 x 10-3 
20 1.3 x 10-5 2.2 x 10-8 1.7 x 10-3 
25 2.0 x 10-5 3.4 x 10-8 1.7 x 10-3 
30 2.9 x 10-5 4.9 x 10-8 1.7 x 10-3 

 
 
Table 4-7:  Deflection and force on Beam 2 with voltages ranging from 5-30 V. 
 

Voltage 
(V) 

Maximum 
Deflection (m) 

Electrostatic Force
(N) 

Spring Constant 
(N/m) 

5 6.0 x 10-7 2.5 x 10-9 4.1 x 10-3 
10 2.4 x 10-6 9.9 x 10-9 4.1 x 10-3 
15 5.4 x 10-6 2.2 x 10-8 4.1 x 10-3 
20 9.6 x 10-6 4.0 x 10-8 4.1 x 10-3 
25 1.5 x 10-5 6.2 x 10-8 4.1 x 10-3 
30 2.2 x 10-5 8.9 x 10-8 4.1 x 10-3 

 

From the above tables, it can be seen that Beam 2 has a higher spring constant 

compared to Beam 1.  The calculated spring constant is ~2.5 times larger than the 

narrower beam which was expected because the beam was 2.5 times wider.  However, 

the electrostatic force is only ~1.8 times larger.  This was also expected, because the 
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thinner beam focused the fringe capacitance so even though the spring constant scales 

linearly with width, the electrostatic force on a micro-ribbon in an array setting does not. 

 Something interesting to note about the above tables is that the spring constant is 

a constant for the respective micro-ribbons no matter how much the micro-ribbon was 

deflected.  This is not the case in a real system.  The more a material is deflected, the 

harder it should be to continue to deflect it.  In COMSOL, there is an option in the plain 

stress module to account for “large deformation” and thus the spring constant that it 

calculates is non-constant.  The more the micro-ribbons are deflected, the harder it 

becomes to deflect them.  This difference becomes significant when the deflection is 

more than the thickness of the beam.  A simulation of Beam 1 was done using this option, 

and the results are found in Table 4-8.  Figure 4.4 shows the nonlinear spring constant 

with “large deformation” on compared to the simulations done with “large deformation” 

off.  The rest of the simulations presented will have large deformation enabled unless 

otherwise stated. 

 

      Table 4-8:  Deflection and force on Beam 1 with voltages ranging from 5-30 V. 
 

Voltage 
(V) 

Maximum 
Deflection (m) 

Electrostatic 
Force  (N) 

Spring Constant 
(N/m) 

5 4.5 x 10-7 8.7 x 10-10 1.9 x 10-3 
10 8.0 x 10-7 2.0 x 10-9 2.5 x 10-3 
15 1.1 x 10-6 3.5 x 10-9 3.2 x 10-3 
20 1.4 x 10-6 5.5 x 10-9 4.0 x 10-3 
25 1.6 x 10-6 7.9 x 10-9 4.9 x 10-3 
30 1.9 x 10-6 1.3 x 10-8 5.8 x 10-3 
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Fig. 4.4:  Graph showing the effects of having the option “Large Deformation” 
enabled.  The spring constant of a beam increases as the beam is 
deflected. 

 
 
4.4  The Number of Segments in the Micro-ribbon 
 
 

Simulations were next carried out for different micro-ribbon designs.  Flexibility 

of the micro-ribbons was enhanced by adding bends to the ribbon creating an in-plane 

spring which increased flexibility.  An investigation was carried out to see what would 

happen with the introduction of more and more jogs or bends.  An arbitrary angle of 22.5˚ 

was chosen for the first set of simulations.  Figure 4.5 shows the geometries of the micro-

ribbons simulated. 
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Fig. 4.5:  Top view of geometries of micro-ribbons at 22.5º angle to the 
longitudinal with 2, 3 and 4 segments.  Each micro-ribbon spanned a 
length of 3 mm.  The actual length of the micro-ribbons varied. 

 

Simulations were first done without the “large deformation” option enabled, 

because these were faster to run computationally.  The micro-ribbons were 20 μm in 

width, 1 μm thick and spanned a length of 3 mm.  The micro-ribbons were 100 μm above 

the pull-down electrode.  The results can be seen in Table 4-9. 

    
  Table 4-9:  Simulated spring constant for micro-ribbons of differing number of segments. 
 

Segments Spring Constant (N/m) 
2 1.1 x 10-3 
3 1.5 x 10-3 
4 1.6 x 10-3 
5 1.6 x 10-3 
6 1.5 x 10-3 
7 1.6 x 10-3 

 

From these simulations, one cannot draw significant conclusions about how the 

number of segments affected the spring constant of the micro-ribbon, other than the 2 

segment micro-ribbons being the most flexible.  Another set of simulations were carried 
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out with the “Large Deformation” option enabled.  The following figure shows the results 

of those simulations (Fig. 4.6). 
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Fig. 4.6:  Simulation of ribbon deflection as a function of voltage for different 
numbers of segments with the “large deformation” option enabled. 

 
 
With the results from these simulations, the 2 segment ribbon again is seen as 

being the most flexible.  The micro-ribbon clearly became stiffer and stiffer as more 

segments were added.  It would appear that as more and more segments are added, the 

micro-ribbon would eventually be equivalent to the straight beam case.  However, these 

simulations only accounted for small deflections (<10 μm).  In the final application, the 

micro-ribbons were expected to deflect 60 μm.   
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Another set of simulations was carried out for the same micro-ribbons but this 

time without rigid adjacent grounds and with uniform pressures applied to the micro-

ribbon resulting in total electrostatic forces of 1x10-7 N and 5x10-7 N (Table 4-10, Table 

4-11).  This was done because the simulations with the rigid adjacent grounds 

underestimate the deflection for a given voltage, as previously discussed.  The 

simulations with a uniform pressure more accurately model the deflection as a function 

of. force.  For these simulations, the “large deformation” option was enabled. 

 
Table 4-10:  Simulated spring constant for 3 mm long and 1 μm thick aluminum micro-

ribbons of differing number of segments with uniform pressure resulting in an 
electrostatic force = 1x10-7 N. 

 
Segments Maximum Deflection (m) Spring Constant (N/m) 
Straight 4.3 x 10-6 2.3 x 10-2 

2 5.2 x 10-5 2.0 x 10-3 
3 2.9 x 10-5 3.5 x 10-3 
4 2.3 x 10-5 4.4 x 10-3 
5 2.1 x 10-5 4.8 x 10-3 
6 2.0 x 10-5 5.2 x10-3 
7 1.7 x 10-5 5.9 x 10-3 

 
 
Table 4-11:  Simulated spring constant for 3 mm long and 1 μm thick aluminum micro-

ribbons of differing number of segments with uniform pressure resulting in an 
electrostatic force = 5x10-7 N. 

 
Segments Maximum Deflection (m) Spring Constant (N/m) 
Straight 7.5 x 10-6 6.7 x 10-2 

2 1.4 x 10-4 3.7 x 10-3 
3 5.8 x 10-5 8.7 x 10-3 
4 4.4 x 10-5 1.2 x 10-2 
5 4.0 x 10-5 1.3 x 10-2 
6 3.7 x 10-5 1.4 x 10-2 
7 3.2 x 10-5 1.6 x 10-2 

 

These simulations clearly show that the spring constant increases with the number 

of segments.  With the larger, more relevant deflections, it is seen that the 2 segment 
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ribbon is the most flexible and the spring constant increases with the number of 

segments. 

 

4.4.1  Micro-ribbons with straight segments at the jogs 
 

Other simulations were carried out using a further slight variation in the design.  

For the sake of discussion, only the 4 segment geometries will be discussed even though 

more simulations were carried out.  The modification to the geometry consisted of adding 

a straight segment at the jogs.  This segment was 100 μm in length.  Simulations were 

also carried out for a 4 segment micro-ribbon with a jog angle of 45˚ to the length axis, 

and for the same micro-ribbon with a straight segment at the jogs.  The geometries are 

shown in Figure 4.7. 

 

 

 
 
Fig. 4.7:  Geometries of 4 segment micro-ribbons with and without straight 

segments at the jogs. 
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Fig. 4.8:  Simulated deflection as a function of voltage for 4 segment micro-
ribbons with and without straight segments at the jogs.  Both 22.5º and 
45º geometries are shown.  The two 22.5º lines overlap each other. 

  
 
The result of these simulations can be seen in Figure 4.8.  It can be seen that 

adding the straight segments does not make a large difference to the flexibility of the 

micro-ribbons.  The straight segments actually made the micro-ribbons slightly stiffer.   

 

4.5  Varying Jog Angles 
 

The jog angle discussed in this thesis refers to the angle the micro-ribbon bends 

off the length axis (Fig. 4.9). 

 

 

Fig. 4.9:  Illustration of the jog angle. 
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In the above simulations (Fig. 4.8), it appears that the 45˚ geometry micro-ribbon 

is significantly more flexible than the 22.5˚ geometry.  However, it is not clear whether 

the angle makes it more flexible, or whether the change in the surface area accounts for 

the increase in flexibility, because the 45˚ geometry micro-ribbon has ~30% more surface 

area.  To further investigate this question, another set of simulations was done to compare 

22.5˚, 45˚, and 67.5˚ geometries.  The surface area was held constant by varying the span 

length of the micro-ribbon.  The 4 segment geometry was used with each segment being 

500 μm in length as seen in Figure 4.10. 

 

 

Fig. 4.10:  Illustration of the 4-segment geometries at 22.5º, 45º, and 67.5º with 
each segment being 500 μm in length. 

 
 
The results of the simulation can be seen in Figure 4.11 which shows the 

maximum deflection vs. voltage.  In these simulations, the electrostatic forces were very 

comparable, since in all cases the micro-ribbons had approximately the same surface 

area. 
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Same Area: Comparison of Deflections
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Fig. 4.11:  Simulated deflection as a function of voltage for the micro-ribbons in 
Figure 4.10 for jog angles of 22.5º, 45º and 67.5º. 

 

From these results, the 22.5˚ geometry is visually more flexible compared to the 

larger angles.  However, for a given span, the larger the angle the more flexible the 

micro-ribbon would be due to the increase in electrostatic force due to the larger surface 

area. 

 

Resonant Frequency: 

Simulations were carried out to investigate the fundamental mechanical resonant 

frequency and spring constant as a function of jog angle.  The following graphs show jog 

angles from 5-45º for a 4 segment beam that spans a length of 3 mm.  The beams were 20 

μm wide and 1 μm thick aluminum.  Smaller angles lead to stiffer beams and therefore 

had a higher resonant frequency.  A device with a resonant frequency of 400 Hz is 
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acceptable for applications that do not require fast switching between different phase 

shifts. 
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      Fig. 4.12:  Simulated resonant frequency vs. jog angle for a 4 segment beam. 
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Fig. 4.13:  Simulated spring constant vs. jog angle for a 4 segment beam. 
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4.6  Simulation of Different Complex Designs 
 
 

It would be beneficial for the final application if there was a straight section in the 

middle of the micro-ribbon.  This straight section should ideally remain relatively flat and 

thus behave better as a ground plane in the phase shifter setup.  Four different geometries 

were simulated.  Again, the 4 segment geometry was used with a straight beam in the 

middle.  The straight section accounted for half the length of the entire micro-ribbon.  

The geometries can be seen in Figure 4.14.  The geometries are referred to as “both up” 

indicating both angled ends are in the same direction, “up/down” indicating that the 

angled ends are in the opposite directions, and “complex 1” and “complex 2” to describe 

the other two geometries accordingly.  There is also one micro-ribbon that has 8 

segments.  This micro-ribbon was used as a comparison.   
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Fig. 4.14:  Illustrations of the more complex geometries simulated. 
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Fig. 4.15:  Simulated deflection as a function of voltage of the various micro-
ribbon geometries of Fig. 4.14. 

 

The results of the simulations can be seen in Figure 4.15.  There is approximately 

a ± 10% range in flexibility between the complex designs; although the 8 segment 

geometry was obviously the most flexible and Complex 2 was the least flexible.   

Another value that was worth examining was the volume of additional air added 

when the micro-ribbons were deflected.  The volume of additional air when the ribbons 

are deflected is a very important parameter because the phase shift is dependent on how 

much air is introduced in the stacked dielectrics.  The following table shows the volume 

of air added at 14 V.  The value was acquired by integrating the deflection across the 

micro-ribbon from the COMSOL solution.  Simulated results are shown in Table 4-12. 
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Table 4-12:  Volume of air present above a micro-ribbon for various ribbon geometries when 
deflected by a 14 V potential. 

 
Micro-Ribbon 

Geometry 
Additional Volume of 

Air Added (m3) 
Maximum 

Deflection (m) 
Both Up 3.3 x 10-13 7.1 x 10-6 

Up/Down 3.5 x 10-13 7.3 x 10-6 
Complex 1 3.3 x 10-13 7.0 x 10-6 
Complex 2 2.8 x 10-13 6.1 x 10-6 
8 Segments 3.9 x 10-13 8.3 x 10-6 

 

 
4.7  Varying Separation Distances between Micro-ribbons 
 
 

An investigation was carried out to determine the role of the separation distance 

between the individual micro-ribbons on the electrostatic force.  Table 4-13 shows the 

calculated force on a micro-ribbon for various separation distances between micro-

ribbons.   The 3D simulations were done on straight beams that were 3 mm in length, 20 

μm in width and 1 μm thick with adjacent rigid grounds (Fig. 4.16).  The micro-ribbons 

were spaced 100 μm away from the pull-down electrode at 50 V.   

 

 

 

Fig. 4.16:  Schematic of the 3D simulation of the micro-ribbon with adjacent 
rigid grounds used to determine the effect of fringing capacitance on 
the electrostatic force. 
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Table 4-13:  Simulated electrostatic force between a 3 mm long and 1 μm thick micro-ribbon 
and a pull-down electrode as a function of inter-ribbon spacing.  The electrode is 
100 μm from the ribbon and is biased to 50 V. 

 
Separation between Ribbons 

(µm) 
Electrostatic Force 

(N) 
5 6.7 x 10-8 

10 7.0 x 10-8 
20 8.5 x 10-8 
40 1.2 x 10-7 
80 1.8 x 10-7 

 
 

It can be seen that there is a gradual increase in the force with increasing 

separation between ribbons.  A second more accurate set of simulations was carried out 

in order to more accurately simulate the real situation.  A 2D simulation of 11 micro-

ribbons was carried out for the geometry of Fig. 4.17.   

 

 

Fig. 4.17:  Schematic of the 2D simulation of 11 micro-ribbons used to model the 
effect of the fringing capacitance on the electrostatic force in an array 
situation. 

 

Having multiple micro-ribbons in the simulation ensured that the fringing 

capacitance was more realistically modeled.  The micro-ribbons were 20 μm in width, 

and 1 μm thick.  They were 100 μm from the pull-down electrode at 50 V.  In the 

simulation, it was assumed that the results would only be accurate for the middle portion 

of the length of the micro-ribbon (Table 4-14).  We can clearly see that a lower actuation 

voltage can be used if the ribbons are spaced further apart.  A plot of this result is given 

in Figure 4.18. 
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Table 4-14:  2D simulation showing the force increase with increasing separation distance 

between 3 mm long and 1 μm thick micro-ribbons.  Ribbons are located 100 μm 
from the pull-down electrode biased to 50 V. 

 
Separation Distance (μm) Electrostatic Force (N/m) 

5 2.6 x 10-5 
10 3.0 x 10-5 
20 3.9 x 10-5 
40 5.4 x 10-5 
60 6.6 x 10-5 
80 8.2 x 10-5 
100 8.6 x 10-5 
150 1.2 x 10-4 
200 1.2 x 10-4 
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Fig. 4.18:  Simulated electrostatic force as a function of micro-ribbon separation 
distance for 3 mm long and 1 μm thick micro-ribbon.  Ribbons are 
located 100 μm from the pull-down electrode biased to 50 V. 

 
 
4.8  Summary 
 
 
 This chapter of the thesis discussed the FEM simulations done using COMSOL 

MultiphysicsTM.  For computational reasons, only one micro-ribbon was simulated with 

adjacent rigid ground planes to account for the fringe fields.  Simulations showed that the 
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spring constant was proportional to the width of the ribbon.   However, with equal 

separation distances between micro-ribbons, the thinner micro-ribbon would have a 

larger electrostatic force due to the effect of fringe fields.  Also, it was shown through 

simulation that the electrostatic force increased with separation distance between micro-

ribbons.  Lastly, for a set span length, having a large jog angle increased the flexibility of 

a micro-ribbon.  The number of segments in the micro-ribbon also determined the 

flexibility of the micro-ribbon.  The most flexible case was a micro-ribbon made up of 

only 2 segments and the flexibility decreased with additional segments.  Additional 

simulations in Appendix B expand on this discussion. 
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CHAPTER 5 
 
 
FABRICATION 
 
 
 
 
 
 
 
 
 
 
5.1  Overview 
 
 
 Micro-ribbon geometries from Chapter 4 were fabricated and observations were 

made about the fabricated micro-ribbon arrays.  This chapter details the fabrication 

process of the aluminum micro-ribbons for the defected ground phase shifter.  A great 

deal of work was done to find an appropriate etch recipe for the plasma etching process to 

release the micro-ribbons, so there is also a lengthy discussion of that process as well.   
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5.2   Fabrication Geometries 
 

 Two fabrication iterations were carried out.  The first set of micro-ribbon arrays 

possessed micro-ribbons 20 μm wide.  After fabrication and testing, it was noted that a 

larger phase shift could be achieved if there was a smaller air gap beneath the micro-

ribbons after the release process.  In an attempt to decrease this initial air gap, micro-

ribbon arrays were fabricated using 5 μm and 10 μm wide ribbons. 

 
5.3  General Fabrication 
 

 The fabrication of the micro-ribbon delay line phase shifter can be broken up into 

3 main parts:  fabrication of the RF substrate, fabrication of the transmission line, and 

fabrication of the micro-ribbon array. 

 
5.3.1  Fabrication of the RF Substrate 
 

 The aluminum micro-ribbon array for the defected ground structure phase shifter 

was fabricated on a 2” high resistivity (3000-5000 Ωcm) RF silicon wafer 250 μm thick 

that was polished and coated with a 1.5 μm layer of silicon oxide (SiO2) on both sides.  

The first step was to take the round wafer and pattern and etch it so that it became 

rectangular in order to fit it in the test fixture.  This was done using a KOH etch (Fig. 

5.1).  Figure 5.1(a) shows the wafer at the initial stage.  The photoresist used was HPR-

504 and the developer used was Microposit-352.  The mask aligner system was an ABM-

6” Contact Mask Aligner with a 350 W bulb.  Photoresist was deposited and patterned 

(Fig. 5.1(b)).  The patterned location in the photoresist eventually became the etch 

grooves along which the wafer was broken to attain the rectangular shape.  Before the 
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BOE etch was carried out, the back of the wafer was masked with protective tape in order 

to protect the silicon oxide on the back side from the solution.  The exposed oxide was 

then etched in a buffered oxide etch (BOE), 10:1 mixture solution, for 40 minutes (Fig. 

5.1(c)).  Once the oxide was patterned, the photoresist was removed and the wafer was 

put in a 30% KOH solution for 2.5 hours at 80ºC.  The oxide acted as a mask in this 

solution while the silicon was etched away.  The KOH etch resulted in a series of “V” 

grooves in the wafer along which the wafer was cleaved (Fig. 5.1(d)).   

 

 

Fig. 5.1:    Fabrication steps to attain a rectangular wafer from a round wafer. (a) 
original wafer. (b) spin on photoresist and do lithography.  (c) etch the 
silicon oxide.  (d) Etch in KOH solution to achieve the “V” grooves. 
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At this point, a piranha cleaning process was applied to the wafer to remove any 

organic materials.  The piranha solution was made up of a 3:1 mixture of H2SO4 and 

H2O2 respectively.  The wafer was allowed to soak for 5 minutes.  The oxide was then 

stripped in a BOE etch for 1 hour.  At this point, the sides of the round wafer were 

cleaved off, but the top and bottom were left intact to prevent the metals to be deposited 

for the transmission line and ground from contacting each other during the subsequent 

sputter deposition steps (Fig. 5.2).  In the figure, the transmission lines run vertically.  

Three transmission lines were built onto a single wafer and under each transmission line 

was fabricated a set of micro-ribbons with different geometries. 

 

 

Fig. 5.2:    Cleaved wafer with top and bottom intact to prevent shorting of top 
and bottom metal deposited in subsequent sputter deposition steps. 

 
 
 
5.3.2  Fabrication of the Transmission Line 

 

The next step in the fabrication process was to make the transmission line on the 

front side of the wafer and the micro-ribbon array on the back side of the wafer (Fig. 5.3).   

 
 



Chapter 5: Fabrication 
 
     

53 

 

 
Fig. 5.3:  Fabrication of the transmission line and the micro-ribbon array. (a) 

aluminum for the transmission is deposited and patterned.  (b) 
aluminum for the micro-ribbons is sputtered and patterned.  (c) the 
micro-ribbons are released using a gas etch process. 

 

The transmission line was made by sputtering a 2 μm layer of aluminum 

according to the recipe found in Table 5-1.  This recipe was chosen for its ability to 

produce micro-ribbons with low levels of internal stress.  Thin film stress measurements 

were carried out using a Toho Technology Corporation FLX-2320-S thin film 

measurement system.  The measured tensile stress for a 1 μm thick aluminum film was 

measured to be 4.3 MPa.  The stress measurements were performed on a separate 4” 

round wafer, because the measurement system required the sample to be round. 

 
           Table 5-1:  Aluminum sputtering recipe. 
 

Parameter Value 
Pressure 16 mTorr 

Ar  65 sccm 
Power 200 W DC 
Time 40 minutes 
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After the aluminum for the transmission line was sputtered, a lithography process 

was used to pattern the transmission line.  After the lithography step, the aluminum was 

etched in an aluminum etch solution at 50 ºC for 6 minutes (Fig. 5.3(a)). 

 The exposure time in the lithography step was very important in the fabrication 

step.  It was not as important for patterning the transmission line but it was very 

important for patterning the thin micro-ribbons.  Exposure times were varied from 10 

seconds to 1 second.  At the longer exposure times, the 5 μm lines for the micro-ribbons 

were over-exposed, which resulted in thinner than desired lines (~2 μm).  At a 2 second 

exposure time, the 5 μm lines were measured visually to be 5 μm; however, the 

photoresist seemed to be under-exposed because the spaces between the micro-ribbons 

appeared to be cloudy.  At 3 seconds, the photoresist was fully exposed but the lines were 

~4μm wide.  Table 5-2 shows the parameters used in the lithography process.   

 
                   Table 5-2:  Lithography process parameters. 
 

Parameter Value 
Spin rate 3000 rpm 

Soft bake temperature 110ºC 
Soft bake time 60 seconds 

Rest time before exposure 5 minutes 
Exposure time 3 seconds 
Develop time 30 seconds 

Hard bake temperature 120ºC 
Hard bake time 20 minutes 

 
 

5.3.3  Fabrication of the Micro-Ribbon Array 
 

The micro-ribbon array was fabricated on the back side of the wafer following 

completion of the transmission line on the front side of the wafer (Fig. 5.3(b)).  A 1 μm 
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thick layer of aluminum was sputtered on the back side of the wafer for the fabrication of 

the micro-ribbon arrays.  Next, the side of the wafer with the transmission line was 

coated with photoresist so that it would not be damaged.  The lithography for the micro-

ribbons was carried out according to the parameters found in Table 5-2.  The aluminum 

micro-ribbons were then etched in the aluminum etch solution at 50 ºC for 2.5 minutes.  

At this point, the wafer was examined under a microscope to determine if more etching 

was required.  Figure 5.4 shows an example with unetched portions, which means that 

more etching is required.  The wafer was then etched for another 30 seconds, and it was 

then determined that the aluminum was etched properly. 

 

Fig. 5.4:  Photograph showing unetched portions in the micro-ribbon array with 
10 μm wide ribbons and 10 μm spacing. 

 
 

Once the micro-ribbon array was patterned, the top and bottom tabs were broken 

off.  A dry release process was then used to release the micro-ribbon array from the 

silicon substrate (Fig. 5.3(c)).  After characterizing many different etch processes and 

recipes, a plasma etch using SF6 gas according to the recipe found in Table 5-3 was found 
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to be the most suitable for releasing the micro-ribbons.  Etch times were dependent on the 

widths of the micro-ribbons. 

 
          Table 5-3:  Plasma etch parameters for dry release. 
 

Parameter Value 
Pressure 300 mTorr 

ICP power 200 W 
RIE Power 30 W 

SF6 flow rate 30 sccm 
 

 
5.4  Investigation of the Dry Release Process 
 

The release method for the micro-ribbons needed to be optimized in order to 

minimize the depth of silicon etched when releasing the micro-ribbons.  In Fig. 1.5, it can 

be seen that the greatest change in the effective permittivity of the stacked dielectrics 

occurred at the initial stage, when the air was introduced to a stacked dielectric made 

completely of silicon.  The shift in effective permittivity becomes less significant the 

more air that is added.  For this reason, it was important to minimize the initial air in the 

stacked dielectrics.  This implies using an isotropic etch to minimize the etch depth 

required to release the micro-ribbon. 
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Fig. 5.5:  Diagram illustrating vertical etch, lateral etch and the peak that forms 
underneath a micro-ribbon in an isotropic etch process. 

 

In Figure 5.5, a few concepts relating to the etch process are illustrated.  The 

vertical etch in an isotropic etch process refers to the depth of the etch.  The lateral etch 

or undercut refers to the horizontal etching that occurs.  In an isotropic etch, the lateral 

etching from both sides of the micro-ribbons will eventually form a peak.  An important 

aspect in the dry release step was to be able to control the etch so that no further etching 

occurred once the micro-ribbons were released.  If this could be done, there should be a 

peak under each micro-ribbon.   With a peak under each micro-ribbon, there was less 

surface area for the ribbon to contact and therefore less likelihood of the micro-ribbon 

sticking to the substrate.  Figure 5.6 shows a peak beginning to form underneath a micro-

ribbon while it was being released. 
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Fig. 5.6:  Photo of a peak forming underneath a micro-ribbon.  It can be clearly 
seen that the center micro-ribbon is being released and is bending over 
the peak. 

 

Two dry etch processes are available at the NSFL at the University of Manitoba:  

XeF2 gas and plasma gas.  Both techniques were investigated in detail for this thesis. 

 
 
5.4.1  Dry etch process test mask 
 

A mask was made to test different dry etch recipes (Fig. 5.7).  Experiments were 

conducted to study both the vertical and lateral silicon etch rates for each of the recipes.  

In these experiments, a silicon wafer with a 2 μm oxide coating was used.  The oxide was 

used as the mask during the silicon etches.  The oxide mask, being transparent, was 

necessary in order to be able to measure the undercut for each recipe since they were 

measured visually with a microscope.  Etch depths were measured using an Alpha-Step® 

500 Profiler and the oxide etch rate was measured using a Nanometrics NanoSpec 210 

system. 
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Fig. 5.7:  Test pattern for testing dry release recipes. 

 
 
5.5   XeF2 Gas Etch 
 
 
 The gas XeF2 is used to etch silicon and results in an isotropic etch.  However, in 

a XeF2 gas etch process, the gas approaches the sample from all directions and thus the 

edges of the etch hole etch faster (Fig. 5.8).  This resulted in an etch profile where the 

edges were etched deeper than the center (trenching). Figure 5.9 shows the etch depths 

measured across the test pattern and shows that indeed, the edges of the sample have a 

deeper etch profile than the center.  The etch profile was a result of 5 pulses of XeF2 gas 

(90 seconds exposed to the gas and 30 seconds of vacuum per pulse).  The apparent slope 

of the wafer surface was a result of the wafer being slightly inclined to the microscope 

stage. 
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Fig. 5.8:  Diagram showing that in a XeF2 gas etch process more gas atoms can 
approach from the side resulting in trenching. 

 

 

Fig. 5.9:  Profile of an etched feature in an XeF2 gas etched wafer.  An etch 
profile that is deeper on the edges due to trenching is visible. 

 
 
 
5.6  Plasma Gas Etch 
 

Plasma etching the sample should yield a more uniform etch profile compared to 

XeF2 because the process is done in an etch system at lower pressures, and with a gas 

input “shower head” that evenly inputs etch gases throughout the chamber.  The NSFL 

has two gases available for etching silicon:  CF4 and SF6.  Since the resulting phase shift 

was dependent on the initial air gap that was a result of releasing the micro-ribbons, a 
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recipe that had a good undercut ratio was desired.  The undercut ratio is defined as 

follows. 

 

EtchVertical
EtchLateralRatioUndercut   =  

 

The gas CF4 was chosen to do a preliminary test on the test-patterned wafer to 

observe the etch profile.  Table 5-4 shows the recipe used.  The Trion plasma etch system 

in the NSFL has an 8” chuck.  Plasma etch systems with a different size chuck would 

require different power levels. 

 
           
                           Table 5-4:  Plasma etch parameters for test pattern sample. 
 

Parameter Value 
Pressure 1000 mTorr 

ICP power 500 W 
RIE Power 25 W 

CF4 flow rate 45 sccm 
O2 flow rate 5 sccm 

Time 15 minutes 
 
 

The CF4 recipe of Table 5-4 resulted in the the following etch profile (Fig. 5.10).  The 

apparent slope of the wafer surface was a result of the wafer being on a slight slope on 

the microscope stage. 
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Fig. 5.10:  Etch profile for plasma etched test wafer.  The plasma gas etch 
process is a more uniform process than XeF2 gas etching, resulting in 
an etch profile that is more uniform in depth. 

 
 
 
5.6.1 CF4 Gas Etch 
 
 
 A total of 5 different CF4 etch recipes were tested.  In these recipes, the CF4 and 

O2 ratios were held constant while the pressure, ICP power and RIE power were adjusted.  

The recipes are shown in Table 5-5, and etch results are shown in Table 5-6. 

 
Table 5-5:  Plasma etch recipes for CF4. 
 

Parameter Recipe 1 Recipe 2 Recipe 3 Recipe 4 Recipe 5 
Pressure (mTorr) 200  400  200  800  1000  
ICP power (W) 350 350 350 500 500 
RIE Power (W) 25 25 10 25 25 

CF4 flow rate (sccm) 45 45 45 45 45 
O2 flow rate (sccm) 5 5 5 5 5 

 

     Table 5-6:  Plasma etch CF4 results. 
 

Recipe Si etch rate 
(μm/min) 

Oxide etch rate 
(μm/min) 

Undercut rate 
(μm/min) 

Ratio 
(undercut:Si)

1 0.41 0.012 0.20 0.50 
2 0.48 0.013 0.28 0.58 
3 0.26 0.008 0.17 0.65 
4 0.60 0.162 0.40 0.67 
5 0.65 0.020 0.47 0.72 
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As can be seen from Table 5-6, recipe 5 has the best undercut to vertical Si etch ratio 

which means that this recipe would result in the minimum initial air gap above the 

fabricated micro-ribbon array. 

  

5.6.2  SF6 Gas Etch 
 

A total of 13 different SF6 etch recipes were tested.  However, only the relevant 

recipes will be shown here.  The remaining recipes and raw data for all the dry etching 

recipes can be found in Appendix C.  In these recipes, the SF6 flow rate was held constant 

while the ICP power and RIE power were adjusted.  The best 5 recipes are shown in 

Table 5-7, and etch results are shown in Table 5-8. 

 
Table 5-7:  Plasma etch recipes for SF6. 
 

Parameter Recipe 1 Recipe 2 Recipe 3 Recipe 4 Recipe 5 
Pressure (mTorr) 300 300 300 45 16 
ICP power (W) 50 0 200 200 50 
RIE Power (W) 50 50 30 50 50 

SF6 flow rate (sccm) 30 30 30 30 30 
 

    
         Table 5-8:  Plasma etch SF6 results. 
 

Recipe Si etch rate 
(μm/min) 

Oxide etch rate 
(μm/min) 

Undercut rate 
(μm/min) 

Ratio 
(undercut:Si) 

1 0.25 0.0006 0.33 1.3 
2 0.12 0.0002 0.26 2.2 
3 1.20 0.0006 0.87 0.73 
4 2.80 0.029 2.00 0.71 
5 1.53 0.018 1.00 0.65 

 
 

Although recipes 1 and 2 had very good undercut ratios, the etches were quite 

slow compared to the other recipes.  Also, because the undercut was measured visually 
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under a microscope, any uncertainty in measuring a small undercut could result in an 

inaccurate undercut to Si ratio.  Recipes 4 and 5 also seemed to have had a good undercut 

to Si ratio, however, they etched the oxide faster as well.  Recipe 3 was chosen to be used 

for the ribbon fabrication in this thesis because it had an acceptable undercut ratio and 

also the speed of ~1 μm/minute was an appropriate speed which allowed for adequate 

control of etch depth. 

  

5.7  Fabricated Micro-ribbons 
 
 
20 μm Micro-ribbons: 

 The first micro-ribbon arrays were made of micro-ribbons that were 20 μm in 

width and they were fabricated underneath a 400 μm wide transmission line (37Ω).  The 

micro-ribbons spanned a length of 3.2 mm.  The jog angle was 22.5º.  The geometry of 

the micro-ribbon can be seen in the following figure. 

 

Fig. 5.11:  Geometry of the 20 μm wide fabricated micro-ribbon. 
 

XeF2 etching was used and resulted in an initial air gap under the micro-ribbons 

of 20 μm at the center, but it was deeper on the edges.  The micro-ribbon array was 2 mm 

wide.  This width was selected such that the array would extend beyond the fringing field 

of the transmission line.  The micro-ribbons had a separation distance of 70 μm in order 
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to take advantage of the force increase with the increase in micro-ribbon separation as 

studied in the simulations. 

 

10 μm and 5 μm Micro-ribbons: 

The 10 μm and 5 μm micro-ribbon arrays were also designed in order to minimize 

the initial air gap.  With a narrower ribbon, the initial air gap would be minimized 

because less silicon etching is required to release the ribbons.  The geometries of the 10 

μm and 5 μm micro-ribbons are shown in the following figure. 

 

 

Fig. 5.12:  Geometries of the 5 μm and 10 μm micro-ribbons. 
 

In Figure 5.12, the jog angles are 45º.  The simulations showed that 45º jog angles 

would result in more flexible micro-ribbons.  The geometries found in Fig. 5.12 (a) and 
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(b) will be referred to as “Both Up” and “Up/Down”, and Fig. 12 (c) will be referred to as 

“8 Segment”.  In the geometries “Both Up” and “Up/Down”, the center straight portion is 

half the length of the micro-ribbon (1.5 mm).  Micro-ribbon arrays were made for each of 

those geometries with 5 μm and 10 μm micro-ribbon widths with 5 μm and 10 μm 

spacings.  The spacings were reduced compared to the first devices in order to minimize 

the air gap under the micro-ribbons when they were released.  These micro-ribbon arrays 

were built underneath a 50 Ω transmission line (250 μm). 

 The SF6-recipe 3 from Table 5-7 was used to release the micro-ribbons.  A 10 

minute etch was carried out to release the 10 μm wide micro-ribbons, and this resulted in 

an initial air gap of 10 μm.  A 5 minute etch was carried out to release the 5 μm wide 

micro-ribbons and this resulted in a 5 μm initial air gap.  The etch progress could be 

observed using the XeF2 system’s microscope.  It could be observed that when some 

micro-ribbons become released because they were no longer in plane with the other 

micro-ribbons (Figure 5.13) and therefore were no longer in focus in the microscope. 

 

 

Fig. 5.13:  Photograph of 10 μm wide micro-ribbons with 10 μm spacing.  
Released ribbons are out of plane and no longer in focus. 
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Once the micro-ribbons were released, the micro-ribbon arrays for the “Both Up” 

and “Up/Down” geometries were found to be unacceptable due to the overlapping of 

some micro-ribbons (Fig. 5.14).  Although deposited aluminum films possessed low 

stress, it is hypothesized that the stress was still sufficient to deform the micro-ribbon 

array so that adjacent micro-ribbons overlapped each other. 

 
(a) 

 

 
(b) 

Fig. 5.14:  Photographs of the 5 μm wide micro-ribbons with 10 μm spacing for 
the “Both Up” geometry showing overlapping micro-ribbons. (a) at 
50x and (b) 100x. 
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As a result of these fabrication difficulties, it was decided that only the “8 

segment” geometries would be tested in the phase shifter application due to the 

overlapping micro-ribbons in the “Both Up” and “Up/Down” geometries.  Pictures of the 

“8 segment” geometry micro-ribbon arrays can be seen in Figure 5.15.  As is seen in the 

figure, the quality of the 8-segment micro-ribbons appeared to be very good.   

 

 
(a) 

 
(b) 

 
Fig. 5.15:  Photographs of the “8 Segment” geometries.  (a) 5 μm wide micro-

ribbons with 10μm spacing at 50x.  (b) 5 μm wide micro-ribbons with 
5 μm spacing at 100x. 
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5.8  Summary 
 
 In this chapter, the fabrication of the micro-ribbon arrays was discussed.  This 

included a discussion of the dry release process.  Three different dry release methods 

were tried, and it was found that a recipe that used SF6 (recipe 3 from Table 5-7) gave the 

desired results of having a good uncut ratio and also a good etch rate.   

 Different sets of micro-ribbons were fabricated with different geometries.  The 

first set of micro-ribbons were 20 μm wide and had an initial air gap of 20 μm with 

deeper air gaps on the side because it XeF2 was used.  In order to decrease the initial air 

gap, thinner micro-ribbons were fabricated at 5 μm and 10 μm widths.  The “Both Up” 

and “Up/Down” geometries were fabricated but deemed not worth testing in the phase 

shift tests because their micro-ribbons overlapped one another.  It was decided that only 

the “8 Segment” geometries would be tested further. 
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CHAPTER 6 
 
 
MICRO-RIBBON DEFLECTION:   TESTING AND MODEL 
VERIFICATION 
 
 
 
 
 
 
 
 
 
 
 
6.1  Overview 

 

In this chapter, the deflection measurement setup and the measurements 

themselves are discussed.  Simulations are also presented for micro-ribbon geometries 

that match the actual dimensions of the fabricated micro-ribbons.  The results of 

experimental and simulation data are compared. Finally, a discussion of thermal 

expansion effects is presented. 
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6.2  Deflection Test Setup 
 
 
 Measurements were carried out in order to investigate the deflection of fabricated 

micro-ribbons as a function of the pull-down electrode actuation voltage.  Measurements 

were made by positioning the micro-ribbon array under a microscope and focusing on the 

middle of one micro-ribbon.  As deflections occurred, the microscope was refocused, and 

the microscope micrometer was used to measure the deflection (the distance the stage had 

to move in order to refocus the image).  Accuracy of the measurements was governed by 

the depth of field of the microscope objective.  These measurements were accurate to ±3 

μm, with the error due to the quality of the microscope micrometer. 

Two different methods were used to measure the deflection.  Since a clear view of 

the micro-ribbon array was required, it was necessary that the pull-down electrode not 

obstruct the view from the microscope.   The first method that was tried was to use a 

piece of aluminum with a tiny hole drilled through it as the pull-down electrode.  The 

microscope was focused through this opening in order to make the measurements.  

However, this technique proved very hard to execute.  The second method was to use a 

piece of glass with a conducting surface as the pull-down electrode.  The glass was 0.5 

mm in thickness and had a coating of indium tin oxide (ITO) that was 150-300 Å thick.  

Indium tin oxide is a conducting material that is colorless and transparent in thin layers 

(Fig. 6.1).   
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Fig. 6.1:  Diagram of the deflection measurement setup showing the placement of 
the microscope, micro-ribbon array and the glass with a conducting 
surface used as the pull-down electrode.   

 

Measurements were made with the micro-ribbons located 120 μm from the 

electrode.  The actual spacing for the micro-ribbon to move though was 60 μm due to the 

need to insulate the pull-down electrode from the micro-ribbon.  Therefore, of the 120 

μm spacing between the micro-ribbon and electrode, 60 μm was air and 60 μm was the 

insulator.  Metal shims were used as a metal contact for the ITO coated glass.  The power 

supply had a 100k Ω resistor in series as a precaution against shorting between the 

grounded micro-ribbon array and the pull-down electrode, which in this case was the 

glass. 

 
6.3  Deflection Measurements 
 
 

Deflection measurements could only be made on the 20 μm wide micro-ribbons.  

The arrays of 10 μm and 5 μm were too difficult to measure accurately because they were 
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too small to be able to focus clearly with the 0.5 mm thick ITO coated glass between the 

microscope and the micro-ribbons. 

The results of the measurements on the 20 μm wide micro-ribbons are shown in 

Table 6-1. Since there were variations in etch depths and thicknesses due to the 

fabrication process, measurements were taken from both the left side and the right side of 

the array.  The actuation voltage was increased by 10 V for each measurement.   

 
  Table 6-1:  Deflection vs. voltage measurements for the 20 μm ribbon array.  The result for 

the ribbons at the left and right side of the array are shown. 
 

Voltage (V) Left Side 
Deflection (μm) 

Right Side 
Deflection (μm) 

0 0 0 
10 22 34 
20 35 41 
30 36 45 
40 44 55 
50 47 58 
60 57 64 

 

6.4  Simulated Deflections 
 
 

The fabricated micro-ribbons spanned a distance of 3.2 mm with jog angles of 

22.5º.  The widths of the micro-ribbons were visually measured under the microscope and 

was 18 μm ±1 μm as opposed to the design width of 20 μm.  The following figure shows 

the geometry of the micro-ribbon. 

 

Fig. 6.2:  Geometry of the simulated 20 μm wide micro-ribbon. 



Chapter 6: Micro-ribbon Deflection: Testing and Model Verification 
 
     

74 

Simulations were carried out to model the behaviour of this design.  These 

simulations had the micro-ribbons located 100 μm away from the pull-down electrode 

instead of the 120 μm as in the test setup.  However, the insulating material was not 

included in this simulation.  If the insulating material had been included, the simulated 

deflections would be larger due to the increase in capacitance because the permittivity of 

plastic is greater than that of air.  The air gap between individual micro-ribbons was 

measured to be 70 μm and thus the simulation also modeled the air gap to be 70 μm.   

The first set of simulations was done without the “Large Deformation” option enabled.  

The results are in Table 6-2. 

 
Table 6-2:  Simulated behaviour of 20 μm wide and 1 μm thick aluminum micro-ribbons 

with the “large deformation” option turned off in COMSOL. 
 

Voltage (V) Maximum 
Deflection (m) 

Electrostatic 
Force (N) 

Spring 
Constant (N/m)

10 1.6 x 10-5 2.0 x 10-8 1.3 x 10-3 
12 2.3 x 10-5 2.9 x 10-8 1.3 x 10-3 

 

A second simulation was done with the “Large Deformation” enabled.  The 

results of the second simulation are found in Table 6-3.  It is clear that the first 

simulation, with “large deformation” off showed a much greater deflection than the 

second simulation but that was because it did not take into account the nonlinear 

behaviour of the spring force with array deflection. 
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Table 6-3:  Simulated behaviour of 20 μm wide and 1 μm thick aluminum micro-ribbons 
with the “large deformation” option turned on in COMSOL. 

 

Voltage (V) Maximum 
Deflection (m) 

Electrostatic 
Force (N) 

Spring 
Constant (N/m)

10 9.0 x 10-6 2.0 x 10-8 2.2 x 10-3 
20 1.7 x 10-5 8.0 x 10-8 4.7 x 10-3 
30 2.4 x 10-5 1.8 x 10-7 7.7 x 10-3 
40 2.9 x 10-5 3.2 x 10-7 1.1 x 10-2 
50 3.4 x 10-5 5.0 x 10-7 1.5 x 10-2 
60 3.9 x 10-5 7.2 x 10-7 1.9 x 10-2 

 
 
 
6.5  Comparison of Simulated and Measured Results 
 
 
 The following shows the results of the simulated and the measured deflections on 

the same graph. 

0

10

20

30

40

50

60

70

80

0 20 40 60 80

Voltage (V)

D
ef

le
ct

io
n 

(μ
m

)

Measured (left)
Measured (right)
Simulated
Iterative

 
 

Fig. 6.3:  Graph showing the simulated and measured deflections of the 20 μm 
ribbon array showing both the left and right side measurements with 
error bars due to the microscope micrometer. 
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As can be seen in the Figure 6.3, the simulation deflections were lower than the 

measured deflections.  It should be noted that the simulations were actually under-

predicting ribbon motion when there was significant deflection because it was not 

recalculating the electrostatic force as the ribbon got closer to the electrode.   

In order to more accurately simulate ribbon motion, iterative simulations were 

done.  These simulations modeled the necessary force to deflect the ribbons.  The 

following graphs show the force vs. deflection (Fig. 6.4) and the force vs. voltage for 

varying ground heights (Fig. 6.5).  The data point labeled “Iterative” on Figure 6.3 was 

obtained by using the graphs in Figures 6.4 and 6.5.  The deflection at 40 V was 

arbitrarily selected for the iterative calculations.  At 40 V, the force can be found on 

Figure 6.5 and this force can then be used to find the corresponding deflection on Figure 

6.4.  The new distance to the ground can be used again to find the corresponding force 

and so on.  The “iterative” solution for the deflection at 40 V, is ~59 μm.  The result of 

these iterative simulations is in closer agreement to the measured results for the 

fabricated micro-ribbons. 
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Fig. 6.4:  Simulated force required for a specific deflection at the center for the 
20 μm wide micro-ribbon fabricated from 1 μm thick aluminum. 
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Fig. 6.5:  Simulated force as a function of actuation voltage for the 20 μm wide 
micro-ribbons at varying ground heights. 

 

Resonant Frequency: 

The resonant frequency was also extracted from the simulations (Table 6-4).  The 

spring constant and resonant frequencies of the micro-ribbons vary significantly as a 

function of their deflection. This is because the ribbons were fixed at both ends.  At rest 

the micro-ribbon was simulated in COMSOL to exhibit a spring constant of 1.2x10-3 N/m 

and a resonant frequency of 430 Hz. However, under application of 0.5 µN evenly 

distributed force, the deflected micro-ribbon was simulated to have a maximum 

deflection of 34 µm at its center.  The resulting spring constant was 1.5x10-2 N/m and the 

resonant frequency was 1500 Hz.  The resonant frequency of the micro-ribbons affects 

how quickly the micro-ribbon deflections can be changed in order to achieve different 
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phase shifts.  The resonant frequency of the micro-ribbons does not refer to the frequency 

of the signal on the transmission line. 

 
Table 6-4:  Calculated resonant frequency for the 20 μm wide, 3 mm long, and 1 μm thick 

aluminum micro-ribbon at different deflections. 
 

Maximum 
Deflection (m) 

Electrostatic 
Force (N) 

Spring Constant 
(N/m) 

Resonant 
Frequency (Hz) 

1.5 x 10-9 1.8 x 10-12 1.2 x 10-3 400 
9.0 x 10-6 2.0 x 10-8 2.2 x 10-3 600 
1.7 x 10-5 8.0 x 10-8 4.7 x 10-3 800 
2.4 x 10-5 1.8 x 10-7 7.7 x 10-3 1100 
2.9 x 10-5 3.2 x 10-7 1.1 x 10-2 1300 
3.4 x 10-5 5.0 x 10-7 1.5 x 10-2 1500 
3.9 x 10-5 7.2 x 10-7 1.9 x 10-2 1700 

 

 
6.6  Thermal Expansion Effects on the Micro-Ribbon Array 

 

A calculation was carried out to investigate the effect thermal expansion would 

have on the micro-ribbon array.  When the micro-ribbons are heated, the aluminum will 

expand according to [8]: 

 
TLL LΔ=Δ α       (6.1) 

 
where L is the length of the micro-ribbon, ΔL, is the change in the length due to thermal 

expansion, αL = 2.5 x 10-5/K for thin film aluminum is the linear thermal expansion 

coefficient, and ΔT is the change in absolute temperature.  The software package 

COMSOL can be used to model thermal expansion.  However, without any applied 

forces, the simulation cannot accurately model in which direction the micro-ribbon would 

deflect (toward the substrate or away from the substrate).  It would be fair to assume that 
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most, if not all, of the thermal expansion would occur in the plane of the array because 

that is how the hinges/bends in the micro-ribbon were designed to deflect.   

It is interesting to calculate the worst case scenario where the micro-ribbon 

deforms entirely in the vertical direction, even though the thermal expansion is likely to 

take place in the horizontal direction. 

 

Fig. 6.6:  Illustration of worst case deflection in z direction due to thermal 
expansion of the micro-ribbon. 

 
 
 
As shown in Figure 6.6, the original micro-ribbon spans the length, L, from A to 

B.  However, when there is a change in temperature, the worst case for deflection is 

having no deformation in the horizontal direction and only deflection in the vertical 

direction.  This is the case where the micro-ribbon is defined by A-C-B, and the 

maximum vertical deflection is Δz, which is determined easily with Pythagorus’ theorem.  

Further investigation would have to be carried out to determine how the micro-ribbon 

geometry will change due to thermal expansion.  This calculation was just to illustrate the 

worst case scenario even though the micro-ribbon was more likely just to buckle rather 

then bend according to Figure 6.6. 

 For thin film aluminum, αL = 2.5 x 10-5/K [8], and assuming a straight micro-

ribbon of 3 mm, the following table of deflections results. 

A B 

C 

ΔZ 

L 

L + ΔL 
2 
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  Table 6-5:  Thermal expansion deflections for 3 mm long, 1 μm thick aluminum micro-
ribbon assuming all deflection in the z direction. 

 
Temperature (ºC) ΔL (μm) Δz  (μm) 

20 0 0 
25 0.375 24 
30 0.750 34 
50 2.250 58 

 

It should be noted that for the case in which the temperature increases by just 5 

ºC, the micro-ribbon becomes 0.375 μm longer which results in a deflection of 24 μm.  If 

the pull-down electrode is 120 μm away from the micro-ribbon, it means that a fifth of 

the air gap (~24 μm) is now unusable to achieve a phase shift.  Figure 6.7 shows the 

deflection of the micro-ribbon for the out of plane deflection worst case scenario from 

20-50 ºC. 
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Fig. 6.7:  Deflection caused by thermal expansion of a 3 mm long, 1 μm thick 

aluminum micro-ribbon assuming all deflection is in the z direction. 
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Again, in practice, the thermal expansion of the micro-ribbon would not all be in 

the vertical direction.  It is fair to expect that most of the expansion will occur in the 

plane of the micro-ribbons under normal operations.   

 

6.7  Summary 
 
 

Deflection measurements were carried out using a micrometer on an optical 

microscope and ITO coated glass as the pull-down electrode.  Only the 20 μm wide sets 

of micro-ribbons were large enough to actually carry out the deflection tests by this 

technique, the others being to small to be brought reliably into focus with the microscope.  
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CHAPTER 7 
 
 
PHASE SHIFT TESTING AND MODEL VERIFICATION 
 
 
 
 
 
 
 
 
 
 
 
7.1  Overview 
 
 
 This chapter begins with a discussion of the phase shift simulations carried out 

using the simulating program HFSS.  Simulations were carried out to determine the 

expected phase shift for specific deflections.  Then phase shift measurements were 

performed for the 20 μm wide micro-ribbons as well as the “8 Segment” 5 μm and 10 μm 

wide micro-ribbons.  Finally, the measured results were compared with the simulated 

results. 
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7.2 RF Background 
 

A generic 2-port RF network is shown in Figure 7.1.  Port 1 is referred to as the 

input port and V1 is the input voltage.  Port 2 is referred to as the output port and V2 is the 

output voltage.  The parameter a1 is the port 1 incident voltage wave; b1 is the port 1 

reflected voltage wave.   

 

 

Fig. 7.1:  A generic 2-port RF network indicating the input and output port 
voltages. 

 

A 2-port RF network can be categorized by its 4 scattering parameters: S11, S12, 

S21, and S22.  The parameter S11 is the ratio of b1 and a1.  The S11 value, sometimes 

referred to as the return loss, in the scattering matrix represents the proportion of the 

incident voltage wave that is reflected back to port 1.  Ideally, for a good transmission 

line, S11 should be zero which indicates there are no signal reflections occurring at the 

input port and all the signal power is entering the network.  The S21 value, sometimes 

referred to as the insertion loss, is the ratio a2 to b1.  This represents the proportion of the 

voltage wave that is transmitted to port 2 from port 1.  
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7.3 HFSS Simulations Setup 
 
 

Phase shift simulations were carried out using the program HFSS [7] to determine 

the expected phase shifts with specific deflections.  HFSS which stands for High 

Frequency Structure Simulator is a commercial finite element method solver for 

electromagnetic structures.  The simulation model was simpler than the actual device in 

order to facilitate the computer aided drawing (CAD) as well as to decrease 

computational time.  The individual micro-ribbons were not simulated.  Instead, a flat 

rectangular membrane was simulated.  It has been reported in [21] that the electrical 

similarity between a solid membrane and a micro-ribbon array means that a simulation 

using a solid membrane can be used.  In [21], in one case a flat membrane was simulated 

and in the other case, an array of straight micro-ribbons that were 42 μm wide with a 42 

μm wide spacing was simulated.  Phase shift and Figure-of-Merit agreed well.  However, 

with the meandering micro-ribbons presented in this thesis, the path length is larger than 

for straight ribbons and therefore a slight increase in line loss would be expected.  Also, 

the simulations would give an over estimation of the phase shift since they assume a 

uniform deflection of the membrane.  In reality, however, the micro-ribbon would not 

have a uniform deflection.  The center of the micro-ribbon would be deflected more than 

the ends because the ends are fixed. 

In this thesis, the geometry of Figure 7.2 was simulated in HFSS.  These 

simulations were used to investigate the effect of having initial air gaps of different 

thicknesses and also to investigate different line impedances that were not considered in 

[21].  A rectangular flat membrane with Lm = 3 mm and Wm = 2 mm was used.  The 
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silicon substrate (εr=11.9, ρ=0.001Ω-cm) had dimensions of L = 6 mm and W = 10 mm 

and thickness of 250 μm and Lf, the feed line length was 1.5 mm. 

 

 

Fig. 7.2:  Simulation geometry for the flat membranes in HFSS. 
 
 
 These simulations were carried out to model the case of having a non-50 Ω feed 

line and also a non-50 Ω membrane.  The mesh size was optimized by HFSS for a center 

frequency of 50 GHz.  This frequency was chosen because it was within the range of the 

highest frequency that accurate measurements could be conducted in the laboratory.   

 
 
7.4  Transmission Line Design 
 

There are two issues that need to be considered when designing the transmission 

line.  The first issue is that the impedance of the transmission line will change with 

deflection of the micro-ribbon array.  Consider, for example, a 37 Ω transmission line 
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over a deflecting membrane.  Figure 7.3 shows the simulated line impedance as a 

function of deflection for a line that is initially a 37 Ω line with no deflection. 
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Fig. 7.3:  Line impedance vs. deflection for a 37 Ω transmission line for the case 
of having no initial air gap and 20 μm initial air gap due to the ribbon 
release process [22]. 

 

 As can be seen in the above figure, the transmission line impedance increases 

(becomes more inductive) with deflection because the capacitance of the line decreases.  

For the case of no initial air gap, the transmission line impedance starts at 37 Ω line, but 

with 60 μm of deflection, the transmission line impedance becomes 56 Ω.  When there is 

a mismatch between the line impedance of the feed line and the line impedance of the 

micro-ribbon array segment, reflections occur at the interface and the signal quality is 

reduced. 

The second issue was that the air gap formed in the fabrication process while 

releasing the micro-ribbons (as mentioned in section 5.7) affects the potential maximum 

phase shift achievable.  This is because the largest gradient change in εeff occurs for air 
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gaps close to 0 μm.  For the case of the 20 μm wide micro-ribbons the initial air gap in 

the center of the array was 20 μm.  Simulations were carried out to investigate the effect 

of the 20 μm initial air gap.  The results are shown in Figure 7.4.  In the “no initial air 

gap” case, the silicon substrate was 250 μm thick, and air was introduced in the stacked 

dielectric by uniformly deflecting the flat membrane 10 μm for each simulation.  In the 

20 μm initial air gap case, the silicon substrate was 230 μm thick and a 20 μm thickness 

of air was present at zero deflection.  Any deflection of the flat membrane added to the 

initial air gap. 
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Fig. 7.4:  HFSS simulation results showing the expected phase shift vs. deflection 
for a fabrication process with no initial air gap and an initial air gap of 
20 μm at 50 GHz for a 3 mm long membrane. 

 

As can be seen in the figure, the initial air gap that was a result of the fabrication 

process substantially reduced the corresponding phase shift for a given deflection.  In the 

case where there was no initial air gap, a deflection of 20 μm caused ~90º phase shift.  In 

the case where there was an initial air gap of 20 μm, a 20 μm deflection only caused a 35º 
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phase shift.  At 60 μm deflection, the difference between the two cases was >60º.  

Therefore, it is important to start off with a minimal air gap.  Appendix D contains further 

HFSS simulations not discussed in this chapter. 

 
 
7.4.1  Transmission Line of 37 Ω 
 
 

Consider the case of a 37 Ω transmission line.  This line would measure 380 μm 

wide for a 250 μm thick silicon wafer.  The S11 and S21 values were simulated for a 6 mm 

long line over a 250 μm thick silicon wafer.  The results are shown in Figure 7.5 and 7.6 

for frequencies ranging from 30 GHz – 70 GHz. 
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Fig. 7.5:  Simulated S11 magnitude for a 37 Ω line for a 6 mm long line and 3 mm 
long membrane. 
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Fig. 7.6:  Simulated S21 magnitude for a 37 Ω line for a 6 mm long line and 3 mm 
long membrane. 

. 
 

 A plot of the simulated S11 at 50 GHz for the 37 Ω line as the membrane is 

deflected is shown in Figure 7.7 for various air gap thicknesses.  The change in 

impedance matching can clearly be seen in the S11 plot as the membrane is deflected.  For 

the 0 μm air gap case, note how the line impedance increased as the membrane was 

deflected and matched 50 Ω around 5 μm of deflection. 
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37 Ohm Line, frequency = 50 GHz
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Fig. 7.7:  S11 magnitude for a 37 Ω line at 50 GHz.  Note how with membrane 
deflection, the line impedance increases and is matched at 50 Ω 
around 5 μm deflection. 

 

 Figure 7.8 and Figure 7.9 show the S21 differential phase and the magnitude as a 

function of deflection for 0, 5 μm, and 10 μm initial air gaps.  True line impedance of 37 

Ω only applied to the case when there was no initial air gap.  With increasing air gap, the 

line impedance increased.  There was significant phase shift potential if the air gap can be 

minimized.  S21 values increased more slowly for the larger deflections. 
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Fig. 7.8:  Simulated differential S21 phase for a 37 Ω line for different air gaps vs. 

deflection at 50 GHz. 
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Fig. 7.9:  Simulated S21 magnitude for a 37 Ω line for different air gaps vs. 

deflection at 50 GHz. 
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7.4.2  Transmission Line of 50 Ω 
 
 

Consider the case of a 50 Ω transmission line.  This line would measure 250 μm 

wide when over a 250 μm thick silicon wafer.  The simulated S11 and S21 can be seen in 

Figures 7.10 and 7.11 for a range of frequencies from 30 GHz – 70 GHz, for a 50 Ω line 

6 mm long with a 3 mm long membrane. 

 

50 Ohm Line, airgap = 0 μm, defl = 0 μm

-50

-45

-40

-35

-30

-25

-20

-15

-10

-5

0

0 10 20 30 40 50 60 70 80

Frequency [GHz]

S1
1 

(d
B

)

 
 

Fig. 7.10:  Simulated S11 magnitude for a 50 Ω line with no initial air gap and no 
deflection. 
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Fig. 7.11:  Simulated S21 magnitude for a 50 Ω line with no initial air gap and no 
deflection. 

 

Figure 7.12 shows the line impedance mismatch at 50 GHz as the ground 

membrane was deflected for the cases of 0 μm, 5 μm, and 10 μm initial air gap.  The 

transmission line impedance was 50 Ω with no initial air gap and no deflection.  Once 

there was an initial air gap of 5 μm or 10 μm, the line impedance was higher than 50 Ω 

initially.  It can be seen that for essentially all cases of the 50 Ω line, S11 is below -10 dB, 

indicating good signal match to the line.  Clearly, a 50 Ω transmission line is superior in 

this application to the 37 Ω line.    

 



Chapter 7: Phase Shift Testing and Model Verification 
 
     

95 
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Fig. 7.12:  Simulated S11 magnitude for a 50 Ω line at 50 GHz.  Note how with 
membrane deflection, the line impedance increases and is no longer 
matched. 

 

Figure 7.13 and Figure 7.14 show the S21 differential phase and the magnitude as 

a function of deflection for 0, 5 μm, and 10 μm initial air gaps.  True impedance of 50 Ω 

only applied to the case of no initial air gap.  With increasing air gap, the line impedance 

increased.  There is clearly significant phase shift potential if the air gap could be 

minimized.  Figure 7.15 shows the differential S21 phase for an initial air gap of 5 μm for 

different frequencies. 
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Fig. 7.13:  Simulated differential S21 phase for a 50 Ω line for different air gaps 

vs. deflection at 50 GHz. 
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Fig. 7.14:  Simulated S21 magnitude for a 50 Ω line for different air gaps vs. 

deflection at 50 GHz. 
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50 Ohm Line, airgap = 5 μm
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Fig. 7.15:  Simulated differential S21 phase for a 50 Ω line with an initial air gap 
of 5 μm for different frequencies. 

 

It can be seen that as the frequency increased, the phase shift also increases.  This 

is because the effective length of the micro-ribbon effectively increases as the frequency 

increases and the wavelength decreases. 

 
 
7.5  Measurements for the 20 μm wide Micro-Ribbons 
 
 

Phase shift tests on the 20 μm wide micro-ribbons were done using an Anritsu 

ME7808A Vector Network Analyzer (VNA).  Phase shift measurements were made by 

placing the phase shifter in Anritsu’s Test Fixture with V-connectors (Fig. 7.16).  Three 

37 Ω transmission lines 3.5 cm long were fabricated on the silicon wafer, each with a 

micro-ribbon array fabricated below them. 
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Fig. 7.16:  Photograph of the phase shifter in the test fixture with V-connectors.  
The pull down electrode can be seen running vertically underneath the 
phase shifter which is propped up by foam. 

 
 

The phase shifter was placed in the test fixture and 1 of the 3 sets of micro-

ribbons was tested at a time.  The pull down electrode was a strip of aluminum that was 

propped up by foam, ensuring good physical contact with the silicon wafer.  The insulator 

used for testing was 3M scotch tape.  The tape had a measured thickness of 60 μm.  The 

distance between the micro-ribbons and the pull-down electrode was 120 μm (Fig. 7.17); 

however, the maximum deflection possible was 60 μm. 
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Fig. 7.17:  Diagram of the pull-down electrode with the tape as an insulator.  Two 
layers of 3M scotch tape is used to form the 120 μm gap between the 
micro-ribbon array and 1 layer is used as the insulator. 

 
 

Phase shift tests were done for the 20 μm wide micro-ribbons built on under a 37 

Ω transmission line (which is not ideal for matching).    After the measurements were 

done, the 20 μm wide micro-ribbons were not damaged, unlike the case for the 5 μm 

wide micro-ribbons that will be discussed later.   

The following tables show the measurements taken at 30 GHz, 40.80 GHz, 49.65 

GHz, 53.85 GHz, and 59.40 GHz for two different arrays of 20 μm wide micro-ribbons.  

For the 53.85 GHz and 59.40 GHz measurements, the device becomes very lossy most 

likely due to the air cavity resonating at those frequencies.  The VNA data for these 

values are found in Appendix E. 
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Table 7-1:  Performance measurements for 20 μm wide micro-ribbons set 1 below a 37 Ω, 
3.5 cm long transmission line. 

 
Freq 

 
 
 
(GHz) 

S11 at 
0V 

 
 

(dB) 

S11 at 
120V 

 
 

(dB) 

S21(dB)/ 
S21(degrees) 

at 0V 

S21(dB)/ 
S21(degrees) 

at 120V  

Differential 
Line Loss 

(0 to 120V) 
 

(dB) 

Differential 
Insertion 

Loss 
(0 to 120V) 

(dB) 

Phase 
Shift 

 
 

(degrees) 

30.00 -12.2 -10.1 -5.50/ 
118 

-5.49/ 
140 -0.18 -0.005 22 

40.80 -10.8 -10.6 -7.37/ 
67.0 

-7.34/ 
100 -0.05 -0.029 33 

49.65 -10.2 -8.13 -7.49/ 
-98.0 

-7.94/ 
-56.9 0.16 0.45 41 

53.85 -10.4 -9.84 -11.1/ 
35.6 

-10.0/ 
60.3 -1.14 -1.08 25 

59.40 -6.75 -6.52 -9.59/ 
-45.1 

-10.5/ 
-23.3 0.88 0.94 22 

 

 
Table 7-2:  Performance measurements for 20 μm wide micro-ribbons set 2 below a 37 Ω, 

3.5 cm long transmission line. 
 

Freq 
 
 
 
(GHz) 

S11 at 
0V 

 
 

(dB) 

S11 at 
120V 

 
 

(dB) 

S21(dB)/ 
S21(degrees) 

at 0V 

S21(dB)/ 
S21(degrees) 

at 120V  

Differential 
Line Loss 

(0 to 120V) 
 

(dB) 

Differential 
Insertion 

Loss 
(0 to 120V) 

(dB) 

Phase 
Shift 

 
 

(degrees) 

30.00 -12.3 -10.1 -5.49/ 
120 

-5.51/ 
141 -0.16 0.02 21 

40.80 -11.3 -11.0 -7.25/ 
67.9 

-7.25/ 
99.6 -0.03 0.002 32 

49.65 -9.81 -8.07 -7.34/ 
-98.8 

-7.77/ 
-57.6 0.18 0.44 41 

53.85 -10.7 -10.2 -10.2/ 
35.5 

-9.51/ 
60.6 -0.77 -0.72 25 

59.40 -6.55 -6.31 -9.37/ 
-44.9 

-10.4/ 
-23.1 0.93 1.00 22 

 

The two different sets of micro-ribbons show great consistency with each other 

when comparing their phase shifts.  The phase shift measurements for both devices are 

very similar.  The line loss is calculated as the insertion loss minus the mismatch loss as 

follows: 
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In equation (7.1), the line loss can be viewed as a ratio of the power coming out of the 

system and the power going in the system ignoring the mismatch loss.  

The following differential phase results were measured at 49.65 GHz (Fig. 7.18).  

A 41º phase shift was achieved at an actuation voltage of 120 V. 
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Fig. 7.18:  Measured differential phase as a function of voltage for the 20 μm 
wide micro-ribbon array (set 2) underneath a 37 Ω transmission line at 
49.65 GHz. 

 
 
 The measured phase shifts were lower than predicted in the simulation (Fig. 7.4).  

This is due to two factors.  First, as mentioned earlier, the simulations over estimate the 

phase shift because they assume uniform ribbon deflections while in reality, the ribbons 

are curved when deflected.  Second, these micro-ribbons were released using XeF2 gas.  

This means that while the initial air gap was 20 μm below the center of the micro-
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ribbons, it was deeper on the edges (~40 μm) due to the trenching effect at the edge of the 

XeF2 etched regions. 

In Tables 7-1 and 7-2, the differential line loss and differential insertion loss 

values represent the line loss and insertion loss respectively due to actuating the micro-

ribbon arrays.  From these values, the Figure of Merit for the ribbon deflection can be 

calculated and are seen in Table 7-3 and 7-4.  Figure of Merit is defined as: 

 

lossline
phaseshiftofreesMeritofFigure   deg  =                                 (7.2) 

 

These Figure of Merit values are useful in determining the losses due to the micro-ribbon 

deflection (the phase shift action) and they do not include the losses of the transmission 

line itself.  Negative Figure of Merit values indicate that differential line loss improved 

during micro-ribbon deflection. 

 
 
Table 7-3:  Figure of merit for 20 μm wide micro-ribbons set 1 for phase shifts from a 120 V 

actuation voltage. 
 

Freq 
 
 
 
 
(GHz) 

Phase 
Shift 

 
 
 

(degrees) 

Differential 
Line Loss 

(0 to 120V) 
 
 

(dB) 

Figure of Merit  
(based on 

differential line loss) 
 
 

(degrees/dB) 

Differential 
Insertion 

Loss 
(0 to 120V) 

 
(dB) 

Figure of Merit 
(based on 

differential 
insertion loss) 

 
(degrees/dB) 

30.00 22 -0.18 -120 -0.005 -4400 
40.80 33 -0.05 -710 -0.03 -1100 
49.65 41 0.16 260 0.45 91 
53.85 25 -1.14 -22 -1.08 -23 
59.40 22 0.88 25 0.94 23 
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Table 7-4:  Figure of merit for 20 μm wide micro-ribbons set 2 for phase shifts from a 120 V 
actuation voltage. 

 
Freq 

 
 
 
 
(GHz) 

Phase 
Shift 

 
 
 

(degrees) 

Differential 
Line Loss 

(0 to 120V) 
 
 

(dB) 

Figure of Merit  
(based on 

differential line 
loss) 

 
(degrees/dB) 

Differential 
Insertion 

Loss 
(0 to 120V) 

 
(dB) 

Figure of Merit 
(based on 

differential 
insertion loss) 

 
(degrees/dB) 

30.00 21 -0.16 -130 0.02 1000 
40.80 32 -0.03 -1100 0.002 16000 
49.65 41 0.18 230 0.44 95 
53.85 25 -0.77 -33 -0.72 -35 
59.40 22 0.93 24 0.99 21.8 
 

For micro-ribbon Set 1, at 49.65 GHz, a phase shift of 41º was achieved with 120 

V actuation voltage and corresponded to a Figure of Merit of 260º/dB of differential line 

loss.  At 40.80 GHz, a phase shift of 33º was achieved with 120 V actuation voltage and 

this case possessed a negative Figure of Merit.  This indicates that there were no losses as 

a result of obtaining the phase shift. 

 
7.6  Measurements for the 5 μm and 10 μm wide Micro-Ribbons 

 

Phase shift tests on the 5 μm and 10 μm wide micro-ribbons were done using an 

Anritsu 37397D Vector Network Analyzer (VNA).  The transmission line fabricated 

above each ribbon array was 50 Ω and 3.5 cm long.  Prior to the phase shift tests, the 

VNA was calibrated using a 1601 point calibration for the frequency range of 20-65 

GHz.  Gore VNA cables were used during the calibration and phase shift tests.  It should 

be noted that even after the calibrations, a change in the S21 of the order of ~0.1 dB could 

be observed by just lifting the cables off the table.  The test fixture was not used in the 

calibration process, so the insertion losses measured could not be used to calculate a 

Figure of Merit for these devices. 
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7.6.1  5 μm wide micro-ribbons 
 

 The 5 μm wide micro-ribbons were fabricated in the “8 segment” geometry as 

discussed in Chapter 5.  Two sets were tested.  One set had spacing between micro-

ribbons of 5 μm and the other set had 10 μm spacing.  The S21 differential phase shift and 

S21 magnitude for these two sets can be found in Figure 7.19 and Figure 7.20.  The 

oscillations seen in the plots were caused by signal reflections along the micro-ribbon 

region interface.  In normal operation, the phase shifter would only have to operate within 

narrow frequency range and will therefore not be affected by the oscillations.   
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Fig. 7.19:  (a) Measured S21 phase shift, (b) S21 magnitude for 5 μm wide micro-
ribbons with 5 μm spacing in the “8 Segment” geometry. 
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Fig. 7.20:  (a) Measured S21 phase shift, (b) S21 magnitude for 5 μm wide micro-
ribbons with 10 μm spacing in the “8 Segment” geometry. 
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Since the length of the transmission line, as a function of RF signal wavelength 

linearly increases with frequency, it would be expected that the phase shift should 

increase linearly with frequency.  However, as can be seen in Figure 7.19, this was not 

the case although a general trend of increasing phase shift with frequency is visible.  

Figure 7.20 shows a more clearly increasing phase shift with frequency.  The actuation 

voltage for the device in Figure 7.20 was not increased past 140 V because it appeared 

that the micro-ribbons were at maximum deflection and a higher voltage could damage 

the micro-ribbons.  It can be seen that there was not a significant increase in phase shift 

when the voltage was increased from 120 V to 140 V. 

 In Chapter 4, simulations showed that with larger inter-ribbon separation 

distances, a lower actuation voltage should be necessary to achieve the same deflection.  

Accordingly, the micro-ribbon array with 10 μm spacing was predicted to offer a higher 

phase shift at the same actuation voltage compared to the 5 μm spaced array.  Figure 

7.21, shows the phase shifts for the two devices at 2 different actuation voltages.  As can 

be seen in the figure, the 10 μm spaced micro-ribbons indeed resulted in a larger phase 

shift at a given voltage due to a larger deflection.  This feature was predicted in the 

COMSOL simulations. 
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Fig. 7.21:  Comparison of measured phase shift results for micro-ribbon arrays 
with ribbons 5 μm in width with two different ribbon separation 
distances. 

 

After the measurements were made, photographs of the micro-ribbon arrays were 

taken (Fig. 7.22).  These photographs show serious damage done to the micro-ribbons.  It 

would appear that 5 μm wide micro-ribbons were too fragile for this application.   

 The resulting phase shifts measured at 50 GHz were lower than the predicted 

phase shifts in Figure 7.13 for initial air gap = 5 μm.  Simulations predicted phase shifts 

greater than 80º while measured phase shifts were ~30º.  This could be due to the fact that 

many of the micro-ribbons seemed damaged and are many microns out of plane and thus 

increased the effective initial air gap. 
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Fig. 7.22:  Photographs of the 5 μm wide micro-ribbons after phase shift tests.  It 
is clear that many micro-ribbons were damaged in the testing process. 

 
 
 

7.6.2  10 μm wide micro-ribbons 
 

The 10 μm wide micro-ribbons were fabricated in the “8 segment” geometry as 

discussed in Chapter 5.  Two sets were tested.  One set had spacing between micro-
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ribbons of 5 μm and the other set had 10 μm spacing.  The S21 differential phase shift and 

S21 magnitude for these two sets can be found in Figure 7.23 and Figure 7.24. 
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Fig. 7.23:  (a) Measured S21 phase shift, (b) S21 magnitude for 10 μm wide micro-

ribbons with 5 μm spacing in the “8 Segment” geometry. 
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Fig. 7.24:  (a) Measured S21 phase shift, (b) S21 magnitude for 10 μm wide micro-
ribbons with 10 μm spacing in the “8 Segment” geometry. 
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Again, the measured phase shifts were lower than the simulated phase shifts in 

Figure 7.13 for the case of a 10 μm initial air gap.  At 50 GHz, the simulated phase shift 

was ~70º while the measured phase shift was only ~25º.  The 10 μm wide micro-ribbons 

held up under the testing process better than the 5 μm wide micro-ribbons (Fig. 7.25).   

 

 
(a) 

 
(b) 

Fig. 7.25:  Photographs of the 10 μm wide micro-ribbons after phase shift tests.  
(a) 5 μm spacing, some micro-ribbons do seem to have distorted, (b) 
10 μm spacing, ribbons seem to all be in good shape. 
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Comparing the two sets of 10 μm wide micro-ribbons at specific actuation 

voltages, Figure 7.26 was obtained.  As can be seen, the ribbon spacing did not make a 

large difference in this case (less than a few degrees).  This was due to the micro-ribbon 

width being larger or equal to the separation distance.  If the ribbon separation distance 

was say 10 μm and 20 μm, then a more significant difference in phase shift for specific 

voltage would be expected similar to the results in Figure 7.21.  It is worth noting that the 

measured results for both the 5 μm and 10 μm spacing cases are in close agreement.  
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Fig. 7.26:  Comparison of measured phase shift results for micro-ribbon arrays 
with ribbons 10 μm in width with two different ribbon separation 
distances. 
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7.6.3  10 μm wide micro-ribbon reproducibility of measurements  testing 
 

Finally, the reproducibility of the measurements is discussed.  For this discussion, 

the micro-ribbon array under study was made up of micro-ribbons that were 10 μm in 

width and had a ribbon separation of 5 μm.  For this experiment, measurements were 

taken at 0 V, 150 V, 0 V, 150 V and then 0 V again in that order (Fig. 7.27). 
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Fig. 7.27: Reproducibility of measurement experiment done on the 10 μm wide 
micro-ribbons with 5 μm spacing actuating the ribbons from 0 V, 150 
V, 0 V, 150 V, and 0 V. 

 
 

As can be seen in the figure above, the measurements at 150 V seem to match 

well between measurements.  This indicates that the ribbon suffered no significant 

damage during deflection and that they returned to the same positions when the same 

voltage was applied.  However, it is also clear that the measurements at the three 0 V 

readings do not match.  This was most likely due to the tape/insulator building up a static 
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charge, which prevents the ribbons from returning to a fully undeflected position.  When 

the power supply was shut off, it was observed through the measured differential phase 

that the micro-ribbons were still settling after 10 minutes.  This issue could likely be 

addressed by using a leaky insulator that would not store a charge.  Figure 7.28 shows the 

same reproducibility test but for the 10 μm ribbon spacing. 
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Fig. 7.28:   Reproducibility of measurement experiment done on the 10 μm wide 
micro-ribbons with 10 μm spacing actuating the ribbons from 0 V, 150 
V, 0 V, 150 V, and 0 V. 

 
 

7.7  Summary 
 
 
 This chapter discussed the phase shift simulations and measurements done on the 

micro-ribbon arrays.  The HFSS simulations showed the importance of minimizing the 

initial air gap that is a result of the fabrication process.  By reducing the initial air gap, the 

required actuation voltage for a given phase shift could be decreased.  Also, through the 
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HFSS simulations, it was shown that a 50 Ω line was better than a 37 Ω line from the 

point of view of mismatch losses. 

 The 20 μm wide micro-ribbons resulted in a 33º phase shift at 40.80 GHz at 120 

V actuation voltage.  The negative Figure of Merit value indicated no losses in the signal 

during a phase shift.  The measured phase shift agreed well with the simulations.  The 5 

μm wide micro-ribbons resulted in a 30º phase shift at 50 GHz.  The measured phase 

shifts did not match well with the simulations and the micro-ribbons were too fragile for 

the applied voltages which resulted in many broken micro-ribbons.  The measured phase 

shift for arrays that had different micro-ribbon array spacing confirmed that having larger 

spacing lowered the required actuation voltage for a given phase shift.  Lastly, the 10 μm 

wide micro-ribbons resulted in a 25º phase shift at 50 GHz with 150 V pull-down 

voltage.  The phase shift was again lower than the simulated results.  Reproducibility of 

measurements was demonstrated by actuating the membranes from 0 V, 150 V, 0 V, 150 

V, and 0 V.  The phase shifts at both 150 V measurements were in agreement.  However, 

the inconsistent phase shifts at the 0 V readings implied that the insulator used in the 

measurements was retaining a static charge. 

 It is recommended to use 20 μm or wider micro-ribbons to ensure durability in the 

phase shifter application.  The fact that the micro-ribbon becomes stiffer with increased 

with can be solved by increasing the separation distance between micro-ribbons.  

However, the resistive losses that occur from increasing the separation distances were not 

studied, so no conclusions can be drawn from that perspective. 
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CHAPTER 8 
 
 
CONCLUSION AND FUTURE WORK 
 
 
 
 
 
 
 
 
 
 
 
8.1 Conclusion 
 
 

A MEMS phase shifter was presented that used a micro-ribbon array integrated 

into the ground plane of a microstrip transmission line.  The micro-ribbons were 

electrostatically actuated away from the RF friendly substrate creating an air gap between 

the micro-ribbons and the transmission line.  The silicon and air form a stacked dielectric.  

By controlling the deflection of the micro-ribbons, an analog phase shift is achieved by 

changing the effective permittivity of the microstrip line. 
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Finite element modeling simulations in COMSOL were carried out in order to 

optimize the geometry of the micro-ribbons.  Simulations showed that by increasing the 

separation distance between micro-ribbons, the electrostatic force increased due to 

fringing fields.  It was also shown that for a given span, a larger jog angle results in a 

more flexible micro-ribbon.  Lastly, it was shown that when the number of segments in 

the micro-ribbons ranged from 3 to 7, there was not a significant increase in the spring 

constant. However, there was a slight increase in the spring constant that was 

proportional to the number of segments. 

Simulations in HFSS were also carried out to simulate the phase shift.  These 

indicated that the initial air gap, formed by releasing the micro-ribbons from the substrate 

in the fabrication process, should be kept at a minimum.  By decreasing the initial air gap, 

a larger phase shift could be achieved for a given micro-ribbon array deflection.  This 

translated to a lower actuation voltage required for a desired phase shift. 

The MEMS phase shifter was fabricated entirely at the NSFL at the University of 

Manitoba.  Different dry release processes were tested in order to determine a recipe that 

would minimize the initial air gap caused due to the release process.  Micro-ribbons of 

widths 5, 10 and 20 μm were fabricated. 

Phase shift measurements were carried out and it was determined that the 5 μm 

wide micro-ribbons were too fragile for the application.  The 10 μm wide micro-ribbons 

were durable enough to survive the phase shift tests, and a phase shift of 25º was 

achieved at 50 GHz with 150 V actuation voltage.  The 20 μm wide micro-ribbons 

performed the best: a 33º phase shift was achieved at 40.80 GHz with an actuation 

voltage of 120 V.  The Figure of Merit was negative indicating that there was no line loss 
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due to ribbon deflection.  At 49.65 GHz, for the same 20 μm wide micro-ribbon array, a 

41º phase shift was achieved with an actuation voltage of 120 V.  The Figure of Merit 

was 260º/dB of differential line loss. 

 
8.2  Future Work and Recommendations 
 
 
 Further improvements can be made in the fabrication process.  It is possible to 

design a process that utilizes a sacrificial layer, most likely photo-resist, in order to 

decrease the initial air gap even further while having wider micro-ribbons.  The 

challenges of such an approach would be to design a micro-ribbon geometry that would 

avoid sticking to the substrate once the micro-ribbons were released.  The introduction of 

dimples on the micro-ribbons would be a possible solution to the sticking problem.  A 

sacrificial based fabrication process would also allow for the phase shifter to be built on 

less lossy, non-silicon substrates. 
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APPENDIX A – COMSOL PROCEDURE 
 

This section of the thesis outlines the procedure to do a typical COMSOL simulation with 

the adjacent rigid ground planes.  The micro-ribbon will be a simple 3 mm x 20 μm x 1 

μm straight beam.  Micro-ribbons with more complex geometries can be done by 

changing the geometry of the micro-ribbon drawn.  The separation distance between the 

ribbons and the adjacent grounds will be 50 μm.  The ground plane will be 4 mm x 3 mm.  

The pull-down electrode is 100 μm below the micro-ribbons.   

 

1. Open COMSOL Multiphysics.  From the “Model Navigator” window, choose “New” 

and “3D” for space dimensions.  In the “Applications Modes”, select “MEMS Module 

– Structural Mechanics – Solid, Stress-strain” and for “Application mode name” enter 

“ps”.  Click OK. 
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2. Now create the micro-ribbon by going to the “Draw” menu and go to “Work Plane 

Settings…”.  Confirm that the following screen appears (z is set to “0” for the x-y 

plane), and click OK. 

 

 

Next, shift-click the “make a rectangle box” and fill in the dimensions as seen in the 

following figure to create a straight micro-ribbon of 3 mm x 20 μm.  Click OK. 
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The geometry for the micro-ribbon is now defined in 2D.  To make the micro-ribbon 

a 3D object, go to “Draw > Extrude…” and enter 1e-6 for the “Distance” parameter 

and click OK. 

3. Next, to define the micro-ribbon as Aluminum, go to “Physics > Subdomain 

Settings…” and select the micro-ribbon and define the material to be “Aluminum 

3003-H18”.  To define the boundary conditions for the micro-ribbon go to “Physics > 

Boundary Settings…”.  Select Boundaries 1 and 6 and set the “Constraint Condition” 

to “Fixed”.  Select the remaining boundaries, 2 through 5, and assign the following 

“Loads” as can be seen in the following figure.  The forces are obtained from the 

electrostatics module and will be defined later. 

 

 

 

Define the boundary expressions that were just added by going to “Options” and 

selecting “Expressions > Boundary Expressions”.  Select Boundaries 2 through 5 and 

type in the following equations. 
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Set the constant for the pull-down voltage by going to “Options > Constants” and 

enter in Vbeam as the “Name” and 10 as the “Expression”. 

4. The last thing that needs to be done to define the mechanical model is to set large 

deformation on.  Go to the “Physics” Menu and select “Properties…” and ensure that 

Large Deformation is on. 

5. Next, it is necessary to define the Electrostatics portion.  Go to “Multiphysics > 

Model Navigator” and add the “MEMS > Electrostatics > Electrostatics module” and 

set the Application mode name to “es”.  Click Add to add the module. 
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6. Next, it is necessary to draw the air that represents the separation distance between 

micro-ribbons.  Go to “Draw > Work Plane Settings” and hit OK.  This will produce 

the 2D view again.  Draw the air gaps by Shift-Clicking the Draw rectangle tool and 

type in the values shown in the following figure: 
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To create the other air gap, click the “array” tool, and enter the following parameters: 

 

Next, select the 2 newly-drawn rectangles and extrude them 1e-6 in the same manner 

as in step 2. 

7. To draw the ground structure, go to “Draw > Work Plane Settings…” and enter 

-100e-6 for the z dimension and click OK.  Next, draw a rectangle with the 

dimension 4 mm x 3 mm.  The resulting screen display should be as follows: 
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Extrude the ground rectangle 100 μm with the same procedure as in Step 2.  Next, go 

to “Draw > Work Plane Settings…” and enter 1e-6 for the z dimension and click OK.  

Extrude the ground plane rectangle 20 μm.  The following figure should result.  All 

the CAD is now complete. 
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8. To set the subdomain settings, go to “Phyics > Subdomain Settings…”. Select 

subdomain 4 and uncheck “Active in this domain”.  The other subdomain sections 

are default to “air”.  Click OK.  Go to “Multiphysics > Mechanical Structures” and 

go to subdomain settings again and make subdomain section 4 the only active domain 

in this domain.  Go to “Multiphyics > Electrostatics”. 

9. To set the boundary settings go to “Physics > Boundary Settings…” set the following 

boundary conditions 

BOUNDARY CONDITION 
1,2,5,6,8,9,10,27,28 ZERO 

CHARGE/SYM
METRY 

3 ELECTRIC POTENTIAL > 
V0 = VBEAM 

EVERYTHING ELSE  GROUND 
 

10. Set mesh settings by going to “Mesh > Free Mesh Parameters” and select 

“Extremely coarse” as the predefined mesh size, and Click OK.  “Mesh elements” 



Appendix A – COMSOL Procedural 
 
     

130 

will have the value 59181 and the “Degrees of Freedom” will have the value 382418.  

Click Solve. 

11. To view the maximum deflection, go to “Postprocessing > Plot Parameters” and 

click “deformed shape” and “boundary” and click OK.  Maximum deflection is  

1.327e-6 m. 

 

 

 

12. To determine the total electrostatic force in the z direction, go to “Postprocessing > 

boundary integration” and select the 4 edges of the micro-ribbon and integrate the 

expression “Fes_z”.  This should give a value of -4.422e-9 N. 
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APPENDIX B – COMSOL SIMULATIONS 
 

Simulations presented in this appendix are meant to supplement the simulations presented 

in chapter 4 of the thesis.  The following tables are some simulations done investigating 

longer micro-ribbons and different thicknesses: 
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Table B-1:  Simulations done investigating longer micro-ribbons and different thicknesses. 
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APPENDIX C – DRY ETCH TESTS RAW DATA 
 

The dry etch process was discussed in chapter 5 of the thesis.  The following is 

just the raw data from the different CF4 and SF6 etch recipes.  Oxide thickness is 

measured with a nanospectrometer, the undercut is measured visually with a microscope 

and the silicon etch rate was calculated by doing depth measurements using the Alpha-

Step. 

 

Table C-1:  CF4 etch recipes. 
 

CF4 Etch Recipes     
      

CF4 45  
Original Oxide 
Thickness = 2.0277  

O2 5     
      

  Pressure         
Recipe (mTorr) ICP (W) RIE (W) CF4 (sccm) O2 (sccm) 

1 200 350 25 45 5 
2 400 350 25 45 5 
3 200 350 10 45 5 
4 800 500 25 45 5 
5 1000 500 25 45 5 

 

Table C-2:  CF4 oxide thickness and oxide etch rate. 
 

  

  
Oxide Thickness (μm) 

  
Oxide Etch Rate (μm/min) 

Recipe 5 min 10 min 15 min  5 min 10 min 15 min 
1 1.964 1.9045 1.8458 0.01274 0.0119 0.01174 
2 1.9641 1.8981 1.8343 0.01272 0.0132 0.01276 
3 1.9956 1.954 1.9075 0.00642 0.00832 0.0093 
4 1.9585 1.8677 1.7841 0.01384 0.01816 0.01672 
5 1.9215 1.8237 1.731 0.02124 0.01956 0.01854 
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Table C-3:  CF4 under cut and under cut rate. 
 

  

  
Under cut (μm) 

  
Under cut Rate (μm/min) 

Recipe 5 min 10 min 15 min  5 min 10 min 15 min 
1 1 2 3 0.2 0.2 0.2 
2 1 2.5 4.25 0.2 0.3 0.35 
3 0.5 2 2.5 0.1 0.3 0.1 
4 1.25 3.25 6 0.25 0.4 0.55 
5 2 4.5 7 0.4 0.5 0.5 

 

Table C-4:  CF4 silicon etch depth and silicon etch rate. 
 

  

  
Silicon Etched (μm) 

  
Silicon Etch Rate (μm/min) 

Recipe 5 min 10 min 15 min  5 min 10 min 15 min 
1 2.136 4.1855 6.0892 0.4272 0.4099 0.3807 
2 2.5059 4.8289 7.2657 0.5012 0.4646 0.4874 
3 1.3044 2.646 3.9325 0.2609 0.26832 0.2573 
4 2.3965 5.5323 9.0159 0.4793 0.62716 0.69672 
5 3.1785 6.6763 9.769 0.6357 0.69956 0.61854 

 

 

Table C-5:  Overall Rates for the CF4 recipes. 
 

Recipe Oxide Etch 
Rate (μm/min) 

Silicon Etch 
Rate (μm/min) 

Under cut Rate 
(μm/min) 

Under cut:Silicon 
Ratio 

1 0.0121 0.4506 0.2 0.4927 
2 0.0129 0.4844 0.2833 0.5849 
3 0.0080 0.2622 0.1667 0.6357 
4 0.0162 0.6011 0.4 0.6655 
5 0.0198 0.6513 0.4667 0.7166 
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Table C-6:  SF6 Etch Recipes and the raw data. 
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Table C-7:  SF6 raw data for the oxide etch rate, silicon etch rate and undercut rate. 
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Table C-8:  SF6 raw data for the undercut rate, si/oxide etch ratios and the lateral to 
vertical etch ratios. 
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APPENDIX D – HFSS SIMULATIONS 
 

This section is meant to supplement the HFSS simulations presented in chapter 7 of the 

thesis.  A transmission line with line impedance of 30 Ω lines with a width of 520 μm 

was also simulated. 

 

30 Ω Line: 

30 Ohm Line, airgap = 0 um, defl = 0 um
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Fig. D.1:  Simulated 30 Ω transmission line S11. 
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30 Ohm Line, frequency = 50 GHz
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Fig. D.2:  Simulated 30 Ω transmission line S11 for different deflections at 50 
GHz. 
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Fig. D.3:  Simulated 30 Ω transmission line differential S21 phase for different air 
gaps. 
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Fig. D.4:  Simulated 30 Ω transmission line differential S21 phase for a 5 μm 
initial air gap for different deflections for different frequencies.  
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50 Ω Line: 
50 Ohm Line, airgap = 5 um

-3

-2.5

-2

-1.5

-1

-0.5

0
0 10 20 30 40 50 60 70

Deflection (um)

S2
1 

(d
B

)

30 GHz
35 GHz
40 GHz
45 GHz
50 GHz
55 GHz
60 GHz
65 GHz
70 GHz

 
Fig. D.5:  Simulated S21 for an initial air gap of 5 μm for different frequencies vs. 

deflection. 
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Fig. D.6:  Simulated S11 for an initial air gap of 5 μm for different frequencies vs. 
deflection. 
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37 Ω Line: 

37 Ohm Line, airgap = 5 um
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Fig. D.7:  Simulated S21 differential phase for an initial air gap of 5 μm for 
different frequencies vs. deflection 
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APPENDIX E – PHASE SHIFT MEASUREMENT DATA 
 

 The following figures are screen shots from the measurements taken on the two 

different sets of 20 μm wide micro-ribbons. 

 

 

Fig. E.1:  Measured return loss (S11), insertion loss (S21) for a reference 
transmission line with no micro-ribbon array. 
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Set 1: 
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Appendix  E – Phase Shift Measurement Data 
 
     

150 

 

Fig. E.2:  Set1 - The measured return loss (S11), insertion loss (S21) and insertion 
phase (S21) of the single membrane phase shifter with the electrostatic 
actuation at the electrode from (a) 0 V, (b) 30 V, (c) 40 V, (d) 50 V, 
(e) 60 V, (f) 70 V, (g) 80 V, (h) 90 V, (i) 100 V, (j) 110 V, (k) 120 v, 
and (l) Reversed 0 V cases.  
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Set 2: 
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Fig. E.3:  Set2 - The measured return loss (S11), insertion loss (S21) and insertion 
phase (S21) of the single membrane phase shifter with the electrostatic 
actuation at the electrode from (a) 0 V, (b) 30 V, (c) 40 V, (d) 50 V, 
(e) 60 V, (f) 70 V, (g) 80 V, (h) 90 V, (i) 100 V, (j) 110 V, (k) 120 v, 
and (l) Reversed 0 V cases.  

 

 

 

 

 


